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Chapter

Introduction

As employee owners of United Airlines, we would like to welcome you to
United Connection®... the most technologically advanced, customer-driven
reservation system on the market.

You're in control

You've been telling us that you want to take control of your travel
planning. United Connection lets you do exactly that, by providing a direct
connection to the same extensive, up-to-the-minute fare and schedule
information available to travel agencies and airlines.

With United Connection, you can:

Make reservations with over 500 airlines, 50 rental car companies,
and 30,000 hotel properties worldwide.

Save your travel preferences in one or more profiles, then let United
Connection use those preferences to streamline your travel planning.

Use the FareShopper™ and SuperShopper®* features of United
Connection to search for low fares over a range of days.

Purchase your ticket online and choose a delivery option. If you're
flying on United or United Express, choose Electronic Ticket to have
your ticket stored electronically in United Airlines' reservation system.

Get up-to-the-minute flight status information, including arrival and
departure times and gates for United and United Express flights.

Check United Mileage Plus” account balance information for yourself
and other travelers.

The power of United Connection begins with you... see for yourself all the
good things that can happen when you take control of your travel plans!
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Hardware and Software Requirements
To use United Connection, you will need the following:

An IBM (or compatible) PC with at least:

A 33 MHz 386DX processor

8 MB of RAM
Microsoft® Windows® 3.1, 3.11, NT 3.51, or Windows 95
A VGA monitor or better (256 colors recommended)

13 MB of available hard disk space (Windows 3.x)
9 MB of available hard disk space (Windows 95)

A Hayes-compatible modem
A mouse, trackball, or other pointing device

How to Get Started

The first time you use United Connection, refer to Chapter 2, Setup and
Registration, for information on:

Installing United Connection.

Registering with United Connection. If you're not already a member of
Mileage Plus, you will be instantly enrolled in the program.

Note: Before you begin using United Connection, be sure you are familiar with
the basics of working in the Windows environment. If you need information on
using a mouse, opening menus, or selecting options from a dialog box, refer to
your Windows documentation.
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Finding what you need to know

This User Manual provides step-by-step instructions that explain how to use
the features that put you in control of your travel plans. You can also use
United Connection’s online Help and Quick Reference Guide. The online
Help provides detailed information about United Connection as you work.
The Quick Reference Guide gives you a brief overview of the steps needed
to accomplish particular tasks. See Chapter 12, Getting Help, for
information about resolving problems.

In this manual

Refer to

For information on

Chapter 2, Setup and
Registration

Chapter 3, Getting
Started

Chapter 4, Profiles and
Preferences

Chapter 5, Creating and
Managing ltineraries

Chapter 6, Selecting
Flights

Chapter 7,
Selecting Rental Cars

Chapter 8, Selecting
Hotel Accommodations

Chapter 9, Reserving
Your Itinerary

Chapter 10, Flight
Status and Mileage Plus

Chapter 11, Other
Options

Chapter 12, Getting
Help

Installing and registering with United Connection.
Learning about United Connection and the travel planning environment,
including the Itinerary Window and the toolbar.

Identifying travelers and their preferences, such as preferred airlines, rental car
companies, and hotel chains.

Creating an itinerary, selecting travelers, saving and opening itineraries,
changing and canceling itineraries, and deleting itinerary files.

Selecting flights based on either schedule or fare (using FareShopper). On
United flights, you can even choose your own seats using a seat map.

Selecting rental cars, getting information about rental car companies, and
requesting special services (such as child car seats or a mobile phone).

Selecting hotel rooms, getting information about specific hotels, and
requesting special services (such as extra beds or a late arrival guarantee).

Choosing a ticketing option (for example, Electronic Ticket or Express
Delivery), paying for your tickets online, and reserving your itinerary.

Checking flight status, reviewing Mileage Plus account information, and
calculating Mileage Plus miles between cities.

Changing system options, finding out about special travel offers, connecting to
the reservation system, and viewing, copying, and printing your itinerary.

Troubleshooting questions and answers, using the online Help and the Quick
Reference Guide, and contacting the United Connection Support Desk.
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Setup and Registration

After you install United Connection, you will need to register. The
Registration Wizard guides you through the following steps:

Choosing a United Connection service provider
Setting up your modem and entering dialing information (if necessary)

Providing your name, phone number, and Mileage Plus® number
(if you don't have a Mileage Plus number one will be assigned to you)

Connecting to the reservation system
Entering a password

Providing credit card information

Note: United Connection now allows you to access the reservation system via
the Internet. You can use any Internet Service Provider with whom you have
an account, including MSN The Microsoft Network” and CompuServe®. If you
do not have an Internet account, connect via the United Airlines Network.
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Installing United Connection

If you are using Windows 95, install United Connection as indicated on the
next page. For all Windows 3.x versions, follow the instructions below.

Note to CD-ROM Users: CD-ROM installation instructions can be found on
the back of the CD sleeve.

To install United Connection on Windows 3.x

1. Start Windows. Close all open applications except Program Manager.

2. Insert United Connection Disk 1 into a floppy drive on your PC.

3. From the Program Manager, select the File menu and choose Run.

=| Run

Lommand Line:

| a\szetup | Cancel

D Run Minimized Browse__.

1

Run dialog box

4. In the command line, type a: \ set up and click OK. (If the diskette is in
drive B, t ype b:\set up and click OK.)
The United Connection Installation window appears.

5. Follow the onscreen instructions to begin the installation.

6. The Setup program asks if you want to install United Connection in the
\UCONNECT directory.

To accept this default, click Next>.

To install United Connection in a new or different directory, click
Browse.

To install in a new directory, type the full path name, including
the new directory name, and click OK. When you are prompted
to create the new directory, click Yes. Then click Next>.

To install in a different directory, select the directory name, click
OK, and then click Next>.

7. Follow the onscreen instructions to complete the installation.
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To install United Connection in Windows 95

1. Start Windows 95.

Insert United Connection Disk 1 into a floppy drive on your PC.
Click Start, click Settings, and then click Control Panel.
Double-click the Add/Remove Programs icon.

Click the Install/Uninstall tab, and then click Install.

Follow the onscreen instructions to begin the installation.

N O o~ W N

The Setup program asks if you want to install United Connection in the
\United Connection directory.

To accept this default, click Next>.

To install United Connection in a new or different directory, click
Browse.

To install in a new directory, type the full path name, including
the new directory name, and click OK. When you are prompted
to create the new directory, click Yes. Then click Next>.

To install in a different directory, select the directory name, click
OK, and then click Next>.

8. Follow the onscreen instructions to complete the installation.

% Starting United Connection

Once you have installed United Connection, you can start the application
as follows:

Windows 3.x: From the Windows Program Manager, double-click the
United Connection icon. The Welcome window appears. Click on the
Travel Planning icon to access the Itinerary Window.

Windows 95: Click the Start button, click Programs, and then click
United Connection. The Welcome window appears. Click on the Travel
Planning icon to access the Itinerary Window.
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If you choose
Internet Service
Provider, MSN, or
CompuServe, you
must have an
account with that
service provider.

Registering with United Connection

You need to register before you can begin using United Connection. The
Registration Wizard guides you through this quick and easy process. Until
you register, the Registration Wizard appears automatically each time you
start United Connection. If you do not choose to register immediately,
select Registration from the Tools menu to start the Registration Wizard.

Choosing a Service Provider

The service provider you choose determines how you will connect to the
reservation system. United Connection provides online access to the
reservation system in two ways: via the Internet, or using the United Airlines
Network. The first three options below allow you to connect to the
reservation system via the Internet. See “Connecting via the Internet” in
Chapter 12 for more information. If you do not have access to any of these
service providers, choose the United Airlines Network.

Internet Service Provider
Choose this option if you have an account with an Internet Service Provider
and would like to use this provider to connect to the reservation system.

MSN (The Microsoft Network)

Choose this option if you have an MSN account and would like to use
MSN's Internet access to connect to the reservation system. MSN is only
available through Windows 95.

CompuServe
Choose this option if you have a CompuServe account and would like to use
CompuServe's Internet access to connect to the reservation system.

United Airlines Network

United Airlines Network is a private telephone network which allows you
to access the reservation system without having to establish an account with
an outside service provider. Anyone may connect to the reservation system
using this option — all you need is a modem and a phone line.
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United Connection
uses Secure
Sockets Layer
encryption for all
Internet Service
Provider
communications.

To choose a United Connection service provider:

1. The Choose United Connection Service Provider dialog box displays a
list of available service providers. Highlight the service provider you
want to use. The default service provider is United Airlines Network.

Choose United Connection Service Provider

LChoosze a service provider:

I United Airlines Network j = | :
ance |
Help |

Choose United Connection Service Provider dialog box

2. To continue, click OK.

Will | be charged for using United Connection?

The only cost associated with using United Connection will be any
connection time charges assessed by your service provider in accordance
with the terms of your agreement with that provider. Some service providers
give you unlimited online access for a flat monthly fee. Others charge by
the minute once you exceed a certain number of hours each month.

If you choose Internet Service Provider, MSN, or CompuServe, contact your
service provider if you are unsure about your billing arrangement.
Currently, there is no charge for using the United Airlines Network except
for the cost of the telephone call to the network (usually a local call).
United reserves the right to change this policy at any time in the future.

Setting up your modem

Important: If you choose Internet Service Provider, MSN, or CompuServe, you
will NOT setup your modem or enter dialing information in United
Connection. Your modem setup and dialing configuration is handled through
your service provider. To continue, go to “Entering Personal Information”.

If you choose United Airlines Network, you will need to setup your
modem. This process varies, depending on your version of Windows. The
Registration Wizard displays the appropriate dialog(s) for your system.

To setup your modem in Windows 3.1, 3.11, or NT 3.51:

1. In the Modem Type dialog box, scroll down the Vendor list and select
the company that makes your modem.

2. In the Modem list, select the modem that matches (or most closely
matches) the modem you will be using.
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If you cannot find an exact match, select Hayes or Hayes-Compatible
from the Vendor list and choose the most appropriate modem.

3. Click Next. The Modem Settings dialog box appears.

Registration Wizard - Modem Settings

Modem Settings

COM Pt (S 2]
Modem Speed: Igggg :I

Speaker Yolume: |

Choose Test Settings to test
0ff High the modem,

Test Settingz

Advanced Settings

Initialization String: ATEFETQ0M1LD 224501

| < Back. I Nexst > I | Cancel I | Help I

Modem Settings dialog box

4. Complete the modem settings as follows:

In this field You can

COM Port Select the communications port used by your
modem. The default is COMT.

Find Port Choose this button if you are not sure which
If you have an COM port your modem is using.
external modem,
be sure to turn it Modem Speed Select the modem speed (baud rate) for your
on before selecting modem. The default is 9600.
the Find Port
option. Speaker Volume Move the slide control left or right to adjust your

modem speaker volume.

Initialization String ~ When you select a modem, United Connection
automatically supplies the appropriate
initialization string for that modem. Modify the
initialization string only if your modem has
special features or commands that you want to
enable. See your modem manual for details.

5. To validate the selected settings, click Test Settings. United
Connection will check the settings and inform you of any problems.

6. After choosing your modem settings, click Next to continue.
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To setup your modem in Windows 95:

1. In the Choose Modem dialog box, select the modem you want to use
with United Connection. If you have more than one modem installed,
click on the arrow to display a list of installed modems.

Choose Modem

Choose a modern for United Connection to use:

[Hayes Optima 268 .34 + F& = : T |
Properties |
Help |

Choose Modem dialog box

2. To change your COM port, baud rate, speaker volume, and other
settings, click Properties. The Windows 95 Modem Properties dialog
box appears.

If you need help on the Modem Properties dialog, click the "?" button in
the upper right corner of the dialog box, then click on an area of the
dialog box to get help for that area.

3. To continue, click OK.

Checking modem status while connected
Windows 95 users can see real-time modem information while connected.

To check modem status:

1. Once you are connected to the reservation system, a small modem icon
appears in the Windows 95 status bar.

If the modem icon does not appear in the Windows 95 status bar,
choose Communications/Modem Settings from the Tools menu in
United Connection. Click Properties, then select the Options tab and
make sure that "Display modem status" is checked.

2. Double-click on this icon to display the modem status dialog box.

3. This dialog box shows you the number of bytes sent and received, the
speed at which the modem is communicating, and the number of
minutes you have been connected.

Note: With data compression, your modem may be able to transmit and
receive data at speeds higher than its maximum rated speed. You set the
maximum speed in the General tab of the Modem Properties dialog box.

4. Click OK to close the Modem Status dialog box.
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Entering dialing information

United Airlines Network users need to enter dialing information and choose
access telephone numbers. The Registration Wizard automatically displays
the Dialing Information dialog box. Enter or select the appropriate
information. At a minimum, you will need to enter a location name and
area code, and select a primary access number.

Registration Wizard - Dialing Information

Calling From Information

Lacation Name: || [Example: “Work™ or "Home""]
Area Code at

this Location: I ™ Always dial aiea code

Dizling Information Dialing Methad Caling Card Infarmation

Prefc 4| & Tone Dialing Tupe: —
r i I |
Suiffis: Pulge Dialing

Long Distance: - I Mumber: I
Access Mumbers  [call 800-635-6225 for other numbers)
Primary: I j
Backup: I j

¢ Back I Mext » I Cancel Help

Dialing Information dialog box

To enter dialing information:

1. In the Dialing Information dialog box, complete the appropriate fields.

In this field You can

Location Name Enter a name for your current location. For
example, Home or Work.

Area Code at this Enter the three-digit area code for this location.

Location

Always dial area Check this box if you need to dial an area code
If you are entering code for all calls (even calls in your own area code).
more than one
code, separate the Dialing Prefix Enter or select the prefix(es) you need to dial
codes with a from this location. Dialing prefixes include the
comma. code needed to get an outside line, or the code

needed to disable Call Waiting.
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In this field

You can

Dialing Suffix

Long Distance

Dialing Method

Calling Card Type
(Windows 95 only)

Calling Card
Number
(Windows 95 only)

Primary Number
If you are not sure
which access
number to select,
call the 800
number displayed
on the dialog box
for assistance.

Backup Number

Enter any number you need to dial after the
primary (or backup) access number is dialed. For
example, when you place a long distance call
from work, you might need to dial an
authorization number to complete the call.

Enter the number you need to dial before dialing
long-distance from this location (usually 1).

Choose Tone or Pulse Dialing. The default is
Tone Dialing (used by touch-tone phones).

If you will be using a calling card from this
location, select your calling card provider.

Note: If your calling card provider is not listed,
you can enter your access number(s) in this field.
If you enter a series of numbers, be sure to
separate the numbers with commas.

If you will be using a calling card from this
location, enter the calling card number.

In the Primary field, type the three-digit area
code for this location and press the down arrow
key. Access numbers for that area code are
displayed in the list.

Select an access number. Modem speeds are
displayed next to each number. Choose a
number that use the highest speed supported by
your modem. Do not select an access number
whose modem speed is faster than your modem.

Select a backup access number just as you
selected a primary number. United Connection
automatically dials the backup number if the
primary number is busy or does not respond.

2. After completing your dialing information, click Next to continue.
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Entering personal information

The Personal Information dialog box appears automatically in the
Registration Wizard. You will need to enter your name, phone number, and
Mileage Plus number (if you are already a Mileage Plus member).

Registration Wizard - Personal Information

Fiegistered Uzer Infarmation

Title: Iﬁ
First Mame: I\ Business Phane: [[ ] -
Last Mame: I Home Phone: [ -

Milzage F’Iusl .

Account
If you are not a member of Mileage Plus®, leave
this field blank and you will be enclled instantly

< Back I Hest > I Cancel Help

Personal Information dialog box

To enter personal information:

1. In the Personal Information dialog box, complete the fields as follows:

In this field You can

First Name and Enter your first and last names.

Last Name

Business Phone Enter your business telephone number.

Home Phone Enter your home telephone number.
At least one phone . . o
umlher fie Mileage Plus Enter your Mileage Plus account number. This is
required. Include Account the number that appears on your Mileage Plus
the area code with card. Important: Do not enter any spaces or
the phone number. dashes between the numbers.

If you are not a Mileage Plus member, leave this
field blank. United Connection will instantly
enroll you in the Mileage Plus program and
assign an account number automatically.
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If you forget your
password, you can
call the United
Connection
Support Desk at
1-800-4UA-CNXN
to get a new one.

2. After entering your personal information, click Next.

United Connection establishes a connection to the reservation system
to complete your registration. If you are using an external modem,
make sure that it is plugged in to a power source and turned on. If you
are not currently a Mileage Plus member, you will be asked to enter
your credit card information before connecting (see below).

Connecting during registration

To complete your registration, United Connection will establish a
connection to the reservation system using the Service Provider you
selected. A status bar indicates the progress of the connection. Refer to
“Troubleshooting” in the online Help if you experience any connection
problems. If you are unable to resolve the problem yourself, contact the
United Connection Support Desk.

Important: If you chose Internet Service Provider, MSN, or CompuServe, see
“Connecting via the Internet” in Chapter 12 for more information.

Entering a password

You need to enter a password during registration. This password will
control access to your information on the reservation system. The Enter
Password dialog box appears automatically in the Registration Wizard.

To enter a password:

1. In the Password field, type the password you want to use. The password
must be 6 to 10 characters long and can include both letters and
numbers. Do not use symbols or spaces.

N

In the Verify Password field, re-type your password.

3. To save your password and continue, click OK.
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Entering registration credit card information

You need to enter credit card information during registration. Credit card
information is required for address verification. The Registration Credit Card
Information dialog box appears automatically in the Registration Wizard.

Note: If you have already registered on another computer and are using the
same United Connection Service Provider, the Registration Wizard displays the
credit card information you entered during the previous registration. Please
verify that this information is accurate before continuing.

Registration Wizard - Registration Credit Card Information

Registration Credit Card

Card Mame: I Example: Pat's Visa
Type of Card: I 'l Expiration D ate: I /
Account Number: I

‘Your address [as shown on credit card statement):

Compary: I [optional)

Address:

I
I
City/State/Zip: |

[ =]

< Back I Mext > I Cancel Help

Registration Credit Card Information dialog box

To enter registration credit card information:

1. In the Registration Credit Card Information dialog box, complete the
fields as follows:

In this field You can

Card Name Enter a descriptive name for the credit card. For
example, Citibank Visa Card.

Type of Card Select the credit card type you are entering.

Account Number Enter the credit card account number. Do not
enter spaces or dashes between the numbers. For
your security, the account number will not be
displayed after credit card validation is complete.
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In this field

You can

Expiration Date

Series Number

Company

Address, City,
State, and Zip

Enter the credit card expiration date using the
format MM/YY or MM/DD/YY. For example,
12/99 or 12/31/99.

If you selected the American Express/Optima
card, a Series Number field appears. Enter the
four-digit credit card series number (also referred
to as the CID, or Customer ID).

Refer to your credit card statement. If your
company name appears on the statement, enter
that name exactly as it is shown. Otherwise,
leave this field blank.

Enter YOUR address exactly as it is shown on the
credit card statement.

2. After entering your credit card information, click Next to continue.

3. If you did not enter a Mileage Plus number in the Personal Information
dialog box, United Connection now displays your new Mileage Plus
number. Please make a note of it, then click Next to continue.

Congratulations... you are now a registered user of United Connection!

Electronic software updates

Periodically, updates to the United Connection software will be released
electronically. When this occurs, a message prompting you to download
the software update will appear after you connect to the reservation system.
Some updates will be mandatory, others optional. Follow the onscreen
instructions to download the software.

Note: For mandatory updates, the software will be downloaded as soon as
you click OK. If you choose No, you will not be able to connect to the
reservation system until you run the download. For optional updates, you
will be able to download the software later.
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Changing Your Communication Settings

After you use United Connection for a while, you might decide to update
your communication settings. This section describes how to:

Change your United Connection Service Provider
Changing your dialing information

Update the expiration date for your registration credit card
Change your password

Additional information about changing your communication settings is
available in the online Help. While you are working in United Connection,
just press F1 and choose the “Setup and Registration” option for detailed
information and instructions.

Changing your service provider

You may change your United Connection service provider at any time.

Note: If you are not sure who your current United Connection Service Provider
is, choose About from the Help menu. The name of your current service
provider is displayed in the About dialog box.

To change your service provider:

1. Make sure you are disconnected from the reservation system. You cannot
change service providers while you are connected.

2. From the Tools menu, choose Change Service Provider. The Change
Service Provider dialog box appears. Your current provider is displayed.

3. Click on the arrow to display the list of service providers. Highlight the
service provider you want to select and click OK.

Only choose Internet Service Provider, MSN, or CompusServe if you
already have an account with that provider. (No separate account is
needed for the United Airlines Network option.)

4. If you are switching to or from the United Airlines Network, you will
need to re-register before you can connect to the reservation system.
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Once your
registration credit
card expires, you
will not be able to
connect to the
reservation system
until you enter the
new expiration
date (or provide a
different card).

Changing your dialing information

Note: This information applies to United Airlines Network users only.

You can change your dialing information at any time. For example, you
would need to change this information if your area code changed, or if you
wanted to select a different telephone access number in your area.

To change your dialing information:

1. From the Tools menu, choose Communications/Dialing
Information. The Dialing Locations dialog box appears.

2. Highlight the location you want to change and click Edit. The Dialing
Information dialog box appears.

3. Change your Dialing Information as needed.

4. To save your dialing information and return to the Dialing Locations
dialog box, click OK. Click OK again to close the dialog box.

Updating your credit card expiration date

When your registration credit card is reissued with a new expiration date,
you must update the information in United Connection. On the first day of
the month in which the credit card is due to expire, United Connection
will begin reminding you to change the expiration date. After the credit
card expires, you will not be able to connect to the reservation system until
you enter the new expiration date (or provide a different credit card).

To update the expiration date for your registration credit card:

1. From the Tools menu, choose Registration. The United Connection
Registration dialog box appears.

2. Click Edit Card. The Registration Credit Card Information dialog box
appears.

3. In the Expiration Date field, enter the new expiration date for that
credit card using the format MM/YY or MM/DD/YY. For example,
12/99 or 12/31/99.

4. Click OK. The United Connection Registration dialog box appears.
5. Click OK again. The Establish Connection dialog box appears.

6. Click Connect to connect to the reservation system and update your
credit card expiration date.
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Forgot your
password?

Call the United
Connection
Support Desk at
1-800-4UA-CNXN
to get a new one.

Changing your password

To help prevent unauthorized access to your itineraries, a password must
be provided each time you connect to the reservation system. You can
change your password at any time.

To change your password:

1. From the Tools menu, choose Change Password. The Change
Password dialog box appears.

2. In the Old Password field, type your current password.

Change Password

Retype Mew Pazsward: l:l

Change Password dialog box

3. In the New Password field, type the new password you want to use.

The password must be 6 to 10 characters long and can include letters
and numbers. Do not use symbols or spaces.

4. In the Retype New Password field, re-type your new password.

5. To save your new password and continue, click OK.
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Online access to
the reservation
system means that
the up-to-the-
minute information
available to
reservation agents
is now available on
your PC.

Getting Started

This chapter provides an overview of the United Connection environment
and how to use it. This includes:

Welcome Window
The Itinerary Window
The toolbar

Using United Connection

Overview

All activity in United Connection is centered around the main window —
the ltinerary Window. What is an itinerary? A set a travel plans... a
blueprint that describes the who, what, where, and when for a particular
trip in precise detail. You're familiar with the itineraries generated by your
travel agent. Now, United Connection lets you take control of your travel
plans by creating your own itineraries — on your own computer.

Using the options available in the Itinerary Window, you specify travelers
and then choose your flights, rental cars, and hotel accommodations. As
you make your selections, the Itinerary Window updates automatically to
display the new information.

At a glance, you can see the names of the selected travelers, the total
current flight cost and flight miles, and detailed information for each flight,
rental car, and hotel reservation. If you are flying on United, you can even
select seats for everyone in your itinerary.

When you are ready to reserve your itinerary, you choose the most
convenient ticketing option — your tickets can be mailed or delivered,
picked up, or (if you are flying United) stored electronically. After you
confirm your reservation, space is allocated on your selected flights, and
your rental car and hotel reservations are forwarded electronically. If you
wish, you can even print a copy of your itinerary for future reference.
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Deselect the
“Show this menu at
startup” option if
you do not wish to
see the Welcome
Window each time
you start United
Connection.

The Welcome Window

When you start United Connection, the Welcome Window appears. Click
on one of the icons in this window to go to the corresponding option.

PERSONAL
PROFILES

Itz easy to
streamling pour
travel planning
with custom
prafiles for pourself
and others... just
chooze your
preferences, and
United Connection
does the rest.

TRAVEL
PLANMIMG

United Connection
putg vou in control
with convenient.
up-ta-the-rinute
infarmation for
over 550 ailines,
50 rental car
companizs, and
200 hatel chains.,

WELCORME 10

UNITED CONNEGTION ™

MILEAGE
FLUS®

Get instant access
to Mileage Flus®
account
infarmation far any
traveler, including
the current
year-to-date
balance and a
surnmary of recent
activity.

FLIGHT
STATUS

Meed to check the
shatus of a United
or United Express
flight? United
Cannection can
show you the
latest schedule
and gate
infiormation at the:
click of a button.

UKITED
INFORMATION

Check. here far the
latest promotional
offers, wacation
packages. and
opportunities ko
earn bonus miles...
s0me only
available to United
Connection
members!

The United Connection Welcome Window

Personal Profiles

Click on this icon to access the Traveler Editor, which lets you create
customized travel profiles for yourself and others.

Travel Planning
Click on this icon to begin planning a trip. You select travelers, then add

flights, cars, and hotels and you're ready to reserve your trip!

Mileage Plus®

Click on this icon to review Mileage Plus account information for yourself
or other travelers. You'll need to register in order to use this option.

Flight Status

Click on this icon to check the status of a specific flight. Up-to-the-minute
information is available for United flights leaving within 48 hours.

United Information

Click on this icon to get the latest information from United Airlines,
including special offers, exciting promotions, and new features.
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The Itinerary Window

The ltinerary Window is the starting point for all United Connection
activities. From here you can edit traveler profiles, view Mileage Plus®
account information, get flight status... and, of course, plan an itinerary.

A round-trip itinerary between New York and Los Angeles is shown below.

Choose toolbar icons to access the Displays information about
most frequently used options. the current itinerary.

: * . Itinl_itn - United Connection
Costs and Mileage E
PlUS m||es(|f File Edit “iew [ltinerary Tool: Help
applicable) are

updated automatically 5l AR D
as you build your ITINERARY
mnerary' Travelers Takals | Motices
1 Stephen Crawford Flight Cost: $2101.00 USD Itinerary Mame: LA, Trip
Car Estimate: a Itinerary Confirmnation Mumber. 42031
. Haotel Estimate: $636.00 USD This itinerary has been reserved.
TO resize a COlUm n, 1 WP Flight biles: 4950 ‘Y'ou must purchase your ticket by Sep 07,
use the mouse to Status Date/Time Location D etails
drag the column
divider left or right.

h Wiyndhamn Hotels Wiyndham Lax Airpor Type: Dk King
Mon 08/02/37 Formerly The Lax Airport Hy Rate: $153.00/night USD
RE! Fri 0B/06/37 310 670-3000 Confirmation #: R2660665
The Status column 1 " United 0020 Class: Business
T Fri  0B/06/97 07:00a Las Angeles Intl [Los Angeles, CA) Seat BB
indicates the status RE Fi  05/05/97 03-4p John F Kennedy Inf [New Yark, NY]
of each item |
(Planned, Selected,
Reserved, etc.).
! ) Feady |Wed 09/04,/96 10:26p | ={]3= Connected b

Indicates whether you are connected to the reservation system. J

Displays information about the highlighted command.

Each area of the Itinerary Window is described on the following pages.
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Menus

All United Connection menus appear in the menu bar at the top of the
[tinerary Window. See "United Connection menus" in the online Help for
more information about each menu and its options.

Toolbar

The toolbar at the top of the Itinerary Window provides immediate access
to the most important United Connection features and functions. See "Using
the Toolbar" below for information about each icon.

Travelers

The names of all travelers in the current itinerary appear on the left side of
the Itinerary Window. Each itinerary can include up to four travelers. The
primary traveler's name appears at the top of the list. See "Selecting
Travelers" in Chapter 5 for more information.

Totals

The following totals are displayed in the center of the Itinerary Window:

Flight Cost Total airfare for all travelers on all selected flights.
Car Estimate Estimated total cost for all rental cars.
Hotel Estimate Estimated total cost for all hotel reservations.

MP Flight Miles Total Mileage Plus flight miles for all United and
United Express flights in the itinerary. Once travel is
complete, the specified miles will be credited to each
Mileage Plus member in the itinerary.

Notices

Displays information relating to the current itinerary, including:
The itinerary name
The flight confirmation number (if flights are reserved)
The ticketing deadline (if flights are reserved but not ticketed)

See "Notices" in the online Help for a full list of items that can appear in the
Notices area.
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A status icon
appears next to
each flight you
add. For example:

Itinerary items

All flights, rental cars, and hotel reservations included in your itinerary are
displayed in the lower half of the Itinerary Window, in date/time order. The
following information is provided for each itinerary item:

Status
Displays the status of each flight, rental car, and hotel reservation in the

itinerary. This includes Planned, Selected, Reserved, or Ticketed.

Date and Time

Flights: Displays the departure and arrival dates and times.
Cars: Displays the pick-up and drop-off dates and times.
Hotels: Displays the check-in and check-out dates.
Location

Flights: Displays the origin and destination airports.

Cars: Displays the pick-up/drop-off location.

Hotels: Displays the hotel location.

Details

Flights: Displays service class and seat assignments.

Cars: Displays the car type and rate.

Hotels: Displays the room type and rate.

Status bar

The following information is displayed in a status bar along the bottom of
the Itinerary Window:

A description of each toolbar icon (when you point to that icon)
A description of each menu option (when you highlight that option)
The current date and time

CONNECTED or NOT CONNECTED (indicates if you are connected to
the reservation system)
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RESERVE

Using the Toolbar

The toolbar at the top of the Itinerary Window includes icons for many
United Connection options. Each icon is described below.

Travelers

Choose this icon to add travelers to your itinerary. See "Selecting Travelers"
in Chapter 5 for more information.

Add Flight

Choose this icon to add a flight to your itinerary. See Chapter 6, Selecting
Flights, for more information.

Add Car

Choose this icon to add a rental car to your itinerary. See Chapter 7,
Selecting Rental Cars, for more information.

Add Hotel

Choose this icon to add hotel accommodations to your itinerary. See
Chapter 8, Selecting Hotel Accommodations, for more information.

Find
Highlight a flight, rental car, or hotel item in the Itinerary Window, then
choose this icon to view availability for the selected item.

FareShop

Choose this icon to select flights using FareShoppers™. See "Selecting
Flights Based on Fare" in Chapter 6 for more information.

Reserve

Choose this icon when you are ready to reserve your itinerary. See Chapter
9, Reserving Your ltinerary, for more information.

Cancel

Choose this icon to cancel your itinerary. See "Canceling a Reserved
[tinerary" in Chapter 5 for more information.

Print

Choose this icon to print a copy of your itinerary. See "Printing an
[tinerary" in Chapter 11 for more information.
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Using United Connection

Creating traveler profiles

In order to use United Connection, you will need to create one or more
traveler profiles for each person who will be traveling. Profiles include
traveler information (name, credit cards, frequent flyer and award
programs), as well as preferences for flights, rental cars, and hotel
accommodations. You enter this information in the Traveler Editor.

You can create multiple profiles for each traveler — for example, a Business
Trip profile, a Family Vacation profile, etc. By choosing different
preferences and service requests for different trip types, you can create
tailor-made itineraries with a minimum of effort. See Chapter 4, Profiles and
Preferences, for more information. Once you have identified travelers and
their preferences, you can start creating an itinerary as follows:

Selecting travelers

The first thing you need to do when creating an itinerary is
to select travelers. Choose the Travelers icon in the toolbar,
then select the travelers you want to include in this itinerary.
See Chapter 5, Creating and Managing ltineraries, for more
information.

Adding itinerary items

F After selecting all of the travelers you want to include in the
’% itinerary, you are ready to add flights, rental cars, and hotel
i 4 accommodations. See Chapters 6 through 8 for information

A0 FLIGHT | on adding these items to your itinerary.

Reserving your itinerary

When you are ready to reserve your itinerary, choose the

Reserve icon in the toolbar. You then review the itinerary

costs, choose a ticketing option, and (if you wish) pay for

REZERVE your tickets online with a credit card. See Chapter 9,
Reserving Your ltinerary, for more information.

Printing your itinerary

Whenever you need a printed copy of your itinerary, just
choose the Print icon in the toolbar. See Chapter 11, Other
Options, for more information about printing.
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Saving your itinerary

You should save your itinerary file before exiting United Connection. To
save your itinerary file, choose Save (or Save As) from the File menu and
enter the required information.

Note that saving an itinerary file does not reserve that itinerary. When you
save an itinerary file, you are storing a copy of that itinerary in the specified
directory on your computer's hard drive. In order to reserve your flights,
rental cars, and hotel accommodations, choose Reserve from the toolbar.

What’s Next

Now that you are familiar with the United Connection workspace, you're
ready to begin checking flights and reserving travel!

If you have not yet created any traveler profiles, you'll need to do this first.
See Chapter 4, Profiles and Preferences, for additional information. If you
have already created traveler profiles, proceed to Chapter 5.



Chapter

Profiles and Preferences

In this chapter you will learn how to identify travelers and specify their
preferences in the Traveler Editor. This includes:

Using the Traveler Editor
Adding a traveler

Creating profiles for travelers
Changing traveler information

Changing profile information

About profiles and preferences

You need to provide traveler information and create at least one traveler
profile for each person you want to include in an itinerary. You enter this
information in the Traveler Editor. The Traveler Editor consists of two
separate areas: Traveler Information and Profile Information. Each of these
areas is described in the following section.
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Using the Traveler Editor

The Traveler Editor dialog box displays a list of travelers and the profiles
associated with those travelers.

Select a Traveler and click
Edit to enter or edit traveler
information. Select a Profile
and click Edit to enter or edit
flight, car, and hotel
preferences and service
requests in that profile.

Traveler Editor

Travelers and Profiles:
L ¥Q M1 Stephien Crawio
l—[i] Busziness Trips

Select a Traveler and click

Delete to delete the
selected traveler and all

= profiles associated with that
traveler. Select a Profile and

then click Delete to delete
that profile only.

Traveler Editor dialog box

Traveler information

You create traveler entries by providing all relevant personal information for
each traveler. Traveler information includes:

Personal information. The traveler's name, home and/or work phone
numbers, traveler type (adult, senior, or child), and home airport.

Payment information. Information about credit cards that the traveler
wants to use to pay for flights or guarantee hotel rooms.

Travel Program information. For example, Mileage Plus” membership.

Discount Program information. For example, discount or corporate
programs sponsored by a rental car company or hotel chain.

While only Personal information is required, you should also enter Payment
information if you want the traveler to be able to pay for itinerary costs.
Also, if the traveler is a Mileage Plus member or belongs to other travel or
discount programs, be sure to enter this information in the corresponding
areas. When you reserve an itinerary, frequent flyer numbers are forwarded
to the appropriate airlines for each traveler in the itinerary. (Other travel
program numbers and discount program numbers are forwarded for the
primary traveler only.)
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You must create a
profile for each
traveler. If you do
not create a profile
after adding a new
traveler, United
Connection creates
a default profile for
that traveler
automatically.

Profiles

After entering traveler information, you need to create a profile for that
traveler. Profiles let you save each traveler's preferences for a particular
type of trip, then apply those preferences when you create an itinerary. For
example, when you’re traveling on business you might prefer to fly in
business class on a specific airline, rent an intermediate size car equipped
with a mobile phone, and stay at hotel with meeting room facilities. When
you are traveling on vacation, you might prefer to fly coach and stay at a
hotel chain that has a pool and baby-sitting services.

Profile information includes:

Flight preferences. Preferred airlines and service class, and acceptable
flight restrictions.

Flight service requests. Preferred seating (for example, aisle or
window), preferred meal, and special services such as a wheelchair.

Rental car preferences. Preferred rental car companies, car types
(compact, intermediate, full-size, etc.), rate range, and companies that
offer in-terminal facilities or unlimited mileage options.

Rental car service requests. Requests for child car seats, a mobile
phone, a ski-equipped car, or a car equipped with hand controls for a
physically challenged driver.

Hotel preferences. Preferred hotel chains, preferred amenities (health
club, meeting rooms, etc.), occupancy (single or double), rate range,
and preferred rate category (weekend, corporate, etc.).

Hotel service requests. Requests for late arrival guarantee, additional
adults or children in room, and roll-away beds or cribs.

Multiple profiles

You can create as many profiles for each traveler as you wish. For example,
a traveler living in Minneapolis might want to create three profiles: one for

routine business trips, one for monthly sales meetings in Chicago, and one

for vacation and weekend leisure travel.

How does United Connection use profiles?

To add a traveler to an itinerary, you select one of that traveler's profiles.
You also specify one traveler as the primary traveler. At your option, United
Connection can use the preferences and service requests from the primary
traveler's profile to customize the current itinerary.



32 United Connection User Manual

Can | change this information?

Yes, you can change traveler and profile information at any time using the
Traveler Editor. As you plan an itinerary, you can also change flight, car,
and hotel preferences on the fly. You can save the changes in the primary
traveler's profile, or use them for the current trip only.

Customizing your profiles
As you specify preferences, consider the purpose of the profile you are
creating. Then, tailor your choices to suit the trip type. For example:

For trips where dates are flexible: Select all fare restrictions and choose
Coach as your service class to get a better fare.

For trips that could require travel on short notice: Create a profile with
few fare restrictions and choose Any as your service class.

For business trips: Choose your company's preferred rental car
company, and preference hotels with meeting facilities.

For leisure travel with the family: Request car seats for the kids, and
hotels that provide a pool and baby-sitting services.
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Adding a Traveler

You need to enter traveler information for each person you want to include
in a United Connection itinerary.

To enter information for a new traveler:

1.

From the Tools menu, choose Traveler Editor. The Traveler Editor
dialog box displays a list of travelers and their associated profiles.

Click Add Traveler. The Personal tab of the Traveler Information dialog

box appears.

To enter traveler information, select the appropriate tab. Information on
the Personal tab is required, all other information is optional.

Select this tab

To enter the following information

Personal

Payment

Travel Programs

Discount Programs

Traveler name, phone number(s), traveler type,
and home airport.

Credit card type, account number, expiration
date, and billing address for each credit card
that will be used to pay for itinerary costs.

Travel program name, account number, sponsor
type, and sponsor name.

Discount program name, account number,
sponsor type, and sponsor name.
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Entering personal information

The Personal tab contains traveler identification information. Follow the
steps below to enter personal information for a traveler.

To enter personal information:

1. In the Traveler Information dialog box, select the Personal tab.

Personal | Fapment | Travel Programs | Dizcount Programs | 4
shons number —
' Tite
First Mame: Business Phone:
Type:
. " Child
Streamline travel & Adult
planning by entering " Senior Citizen
the traveler's home Home Airport
airport. [John F Kennedy Intl (New York, NY) -]

Traveler Information dialog box, Personal tab



Chapter 4: Profiles and Preferences 35

Children under two
are classified
automatically as
infants.

2. Complete the Personal information as follows:

In this field

You can

Title

First and Last
Name

Business Phone

Home Phone

Type

Birthdate

Home Airport

Select a title (optional).

Enter the traveler’s first name and last name.

Enter the traveler’s business phone number.
Enter the traveler’s home phone number.

Select Child, Adult, or Senior Citizen using the
following age categories:

Age Range Type
0-11 years Child
12-64 years Adult
65 or more years Senior Citizen

If you choose Child or Senior, a date field
appears. Enter the traveler's birthdate using the
format MM/DD/YYYY. For example, 08/10/1922.

Enter or select the home airport for this traveler.
This is the airport that he or she will be departing
from most frequently.

See "Using the Airport Search Option" in Chapter
11 for help using this feature.

3. To continue entering traveler information, select the Payment tab and
enter the traveler's payment credit card information.
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Entering payment credit card information
The Payment tab allows you to enter the credit cards that the traveler wants
to use to pay for airline tickets and reserve hotel rooms. Follow these steps
to enter Payment information for a traveler.
To enter payment credit card information:
1. In the Traveler Information dialog box, select the Payment tab.
2. Click Add. The Credit Card Information dialog box appears.
Do not enter any Credit Card Information
spaces or dashes Payment Credit Card
between the numbers. Card Mame: || | Example: Pat's Viza
Type of Card: | j| Expiration Date: l:l
Account Humber: | |
Enter the traveler’s ]
address eXaCﬂy as Your address [as shown on credit card statement]: -ﬂelp
shown on their Coreen | | [optional]
credit card billing —— | Addess: | |
statement. | | /-{7[
Ciy/State/Zip: | || =1 | )

Credit Card Information dialog box
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3. Complete the Credit Card Information fields as follows:

In this field You can

Card Name Enter a descriptive name for the credit card. For
example, Corporate American Express.

Type of Card Select the type of credit card you want to use.

Account Number Enter the credit card account number. Do not
enter spaces or dashes between numbers. For
your security, the number will not be displayed
after credit card validation is complete.

Expiration Date Enter the credit card expiration date using the
format MM/YY or MM/DD/YY. For example,
12/99 or 12/31/99.

Series Number If displayed, enter the four-digit credit card series
number (also referred to as the CID, or Customer
ID). This field only appears if you selected the
American Express/Optima card.

Company If the credit card billing statement is sent to the
traveler's company, enter the company name
exactly as it appears on the statement.
Otherwise, leave this field blank.

Address, City, Enter the traveler's address exactly as it is shown
State, and Zip on the credit card billing statement.

4. When you are finished entering credit card information, click OK to
return to the Payment tab.

5. To enter another payment credit card, repeat steps 2 through 4.

6. To continue entering traveler information, select the Travel Programs
tab and enter the traveler's travel program information.
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Entering travel program information

The Travel Programs tab allows you to enter the travel programs in which
You cannot apply the traveler is a member (for example, frequent flyer programs). This
for membership to information is optional. If provided, it will be forwarded to the appropriate
hew programs sponsor (airline, car rental car company, or hotel chain) when the traveler's

h h Uni L . . .
throug .Un'tEd itinerary includes a reservation with that sponsor.
Connection — only

enter travel To enter travel program information:
programs in which ] )
theltravelerlis 1. In the Traveler Information dialog box, select the Travel Program tab.

IR E TEml o 2. Click Add. The Frequent Traveler Program Information dialog

box appears.

Frequent Traveler Program Information

Travel Program

Mame: |Mileage Plus

Example: Mileage Pluz®
Account: I:I
Sponsor
Tvper | diline =]
Campany: | United Aifines Inc j|

Frequent Traveler Program Information dialog box

3. Complete the Frequent Traveler Program Information fields as follows:

In this field You can

Name Type the name of the travel program that you
want to include for this traveler.

Account Type the traveler's account number or
membership number for that program.

Type Select the type of company that sponsors the
travel program.

Company Select the sponsor company name.

4. When you have finished entering travel program information, click OK
to return to the Travel Programs tab.

5. To enter another travel program, repeat steps 2 through 4.

6. To continue entering traveler information, select the Discount
Programs tab and enter the traveler's discount program information.
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Each traveler is
limited to one
discount program
per sponsor.

Entering discount program information

The Discount Programs tab allows you to enter the discount programs in
which the traveler is a member. This information is optional. If provided, it
will be forwarded to the appropriate sponsor (car rental company or hotel)
when the traveler's itinerary includes a reservation with that sponsor.

To enter discount program information:

1. In the Traveler Information dialog box, select the Discount Program
tab.

2. Click Add. The Discount Program Information dialog box appears.

Discount Program Information

Discount Program

Narne: || |
Example: Hertz Corporate Digcount

Sponsor
e
LCompany: | j|

Discount Program Information dialog box

3. Complete the Discount Program Information fields as follows:

In this field You can

Name Type the name used to reference the discount
program. For example, "TownLine Bank
Employee Discount."

Account Type the account or membership number.

Type Select the type of company that sponsors the
discount program.

Company Select the sponsor company name.

4. When you have finished entering discount program information, click
OK to return to the Discount Programs tab.

5. To enter another discount program, repeat steps 2 through 4.

6. When you have finished entering traveler information, click OK. The
Trip Profiles dialog box appears.
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The Trip Profiles
dialog box appears
automatically after
you create a new
traveler. If you do
not create a profile,
United Connection
creates a default
profile
automatically.

Creating a Profile

You need to create at least one profile for each traveler. Profiles contain the
traveler's preferences and service requests for flights, rental cars, and hotels.
You can create multiple profiles for each traveler, choosing different
preferences and services for different trip types.

To create a profile:

1. From the Tools menu, choose Traveler Editor. The Traveler Editor
dialog box displays a list of travelers and their profiles.

2. Select the traveler for whom you want to create a profile and click
Add Profile. The Trip Profiles dialog box appears.

3. In the Profile Name field, type a unique name for this profile. For
example, Business Meetings or Weekend Trips.

4. To enter preferences and service requests, select the appropriate tab.
All information is optional.

Select this tab To enter the following information

Flights Preferred airlines, preferred service class, acceptable
fare restrictions.

Flight Requests Preferred seating, special meal request, special
services (such as a wheelchair at the airport).

Car Preferred rental companies, preferred car types,
acceptable rate range, in-terminal facilities, unlimited
mileage option.

Car Requests Infant/toddler car seats, car phone, ski-equipped car,
hand controls.

Hotel Preferred hotels, occupancy, amenities, rate
category, acceptable rate range.

Hotel Requests Late arrival guarantee, additional guests in hotel
room, extra beds or cribs.
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Specifying flight preferences

Flight preferences include preferred airlines, preferred service class, and
acceptable fare restrictions. If you choose the Use Preferences option in
the Select Flight dialog box, United Connection will use the primary
traveler's flight preferences to narrow the search for acceptable flights.

To specify flight preferences:
1. In the Trip Profiles dialog box, select the Flight tab.

Enter a unique name for 5
each profile. For
example, Sales Meetings,
Branch Office Visits,

rip Profiles

Traveler: Hr Stephen Crawford
Profile Name: |Business Trips |

Vacation, etC. Flight | Flight Requests | Car | Car Requests | Hatel | Hotel Requests | _
Preferred Airlines A ble Fare R icti Cancel
|United Airlines Inc j| ¥ Minimum Stay Fequired _

. o . |<Nune> j| ¥ Magimum Stay Required .

United Airlines is preset as = E ¥ advanced Purchase Required

one of the preferred

airlines. This selection Preferred Service Class

cannot be changed. You [Business <]

can select two additional

preferred airlines.

Trip Profiles dialog box, Flight tab

2. Enter the traveler’s flight preferences as follows:

In this field You can

Preferred Airlines Select the traveler’s preferred airlines.

Preferred Service Select a class. Options include First, Business,
Class Coach/Economy, and Any. The default is Any.
Acceptable Fare Select the fare restrictions the traveler is willing to
Restrictions accept when pricing a flight. These include:

Minimum Stay Required
Maximum Stay Required
Advance Purchase Required

By default, all fare restrictions are selected.

3. To continue entering profile information, select the Flight Requests tab
and enter the traveler's flight service requests.
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Specifying flight service requests

Flight services include preferred seating, special meal requests, and special

United Connection services. All travelers' flight service requests are forwarded to the

cannot guarantee appropriate airlines when you reserve an itinerary.

flight service

requests. Please To specify flight service requests:

call the airline . . . )

directly to confirm 1. In the Trip Profiles dialog box, select the Flight Requests tab.

your requests.

Trip Profiles

Traveler: Mr Stephen Crawford
Profile Mame: |Business Trips |

Car Requests I Hutel | Hotel Requests

Prefered Seating: | Aizle j|
Preferred Meal: | Mo Special Request j|

Special | <Monex ﬂ|

Other special services mayp be available. For more information, please contact the camier.

Trip Profiles dialog box, Flight Requests tab
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Heart Smart™
meals are preceded
in the list by the
Heart Smart logo.

2. Enter the traveler’s flight service requests as follows:

In this field

You can

Preferred Seating

Preferred Meal

Special

Select the traveler's seating preference. Seating
options include:

None

Aisle seat

Any seat

Window seat

The default option is Aisle seat.

Select the traveler's special meal preference. The
default option is No Special Request.

Certain restrictions apply to special meal
requests. Refer to the online Help for details.

Select any special services the traveler requires.
For example, you can request a wheelchair for
use at the airport.

Note that wheelchair users must be able to
ascend and descend stairs. If further assistance is
required, please contact the airline directly.

3. To continue entering profile information, select the Car tab and enter
the traveler's rental car preferences.
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Specifying rental car preferences

Rental car preferences include preferred rental companies, preferred car
types, acceptable rate range, and preferences for in-terminal facilities or
unlimited mileage. If you choose the Use Preferences option in the Select
Rental Car Company dialog box, United Connection will use the primary
traveler's rental car preferences to narrow the search for rental cars.

To specify rental car preferences:
1. In the Trip Profiles dialog box, select the Car tab.

Trip Profiles [ %]

Traveler: Hr Stephen Crawford

Profile Name: |Business Trips |

Flight | Flight Requests Car Requests | Hatel | Hotel Requests |

Preferred Rental Companies Acceptable Rate Range
[<Nare || | T gearchWihin Prize Range
[Hare> o] | Hwesse [T
= R
Fiates for 1.5 locations only
Preferred Car Types Options
|<Nune> j' Only shaw rental car companies with:
| <Mone> j| I™ In Teminal Facilties

| <Mone> j| ™ Unlimited Mileage

Trip Profiles dialog box, Car tab
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2. Enter the traveler’s rental car preferences as follows:

In this field

You can

Preferred Rental
Companies

Preferred Car
Types

Search Within
Price Range

In Terminal
Facilities

Unlimited Mileage

Select the traveler’s three preferred rental car
companies. The default is None.

Select the traveler’s three preferred car types. The
default is None.

Select this option if you only want to see rental
companies that offer rates within a price range
you specify. Then, do the following:

a. In the Highest Rate field, enter the highest
daily rate you want to pay for a rental car.

b. In the Lowest Rate field, enter the lowest
daily rate you want to pay for a rental car.

Select this option if you prefer to rent cars from
companies that have service desks located in the
airport terminal, rather than at a remote airport
location (that may require shuttle service).

Select this option if you prefer to rent from
companies that offer an unlimited mileage plan.

3. To continue entering profile information, select the Car Requests tab
and enter the traveler's rental car service requests.
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Specifying rental car service requests

Unfies] Commaciion Rental car services include infant and toddler car seats, controls for

cannot guarantee physically challenged drivers, mobile phone, ski-equipped car, and
rental car service associated frequent flyer program. Rental car service requests are
requests. Please forwarded for the primary traveler only.

call the company

directly to confirm To request car services:

your requests.
1. In the Trip Profiles dialog box, select the Car Requests tab.

Trip Profiles

Traveler: tr Stephen Crawford
Profile Mame: |Business Trips |

F\ightl Flight Requests Car CalFleques | Hotell Haotel Requests

Additonal Service Requests

™ Infant Car Seat
™ Toddier Car Seat Help

™ Car Equipped for Physically Challenged Diiver
€ Lot Hand|Eantals
€ \Bight Hand Catitiols

I™ Mobile Phone Requested
I Ski-equipped Car (skirack, snow tires, ete.)

Assaniated Erequent Blrer Bragran:

| o

Trip Profiles dialog box, Car Requests tab
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2. Enter the traveler’s rental car service requests as follows:

In this field

You can

Infant Car Seat
Toddler Car Seat
Car Equipped for
Physically
Challenged Driver
Mobile Phone
Ski-Equipped Car

Associated
Frequent Flyer
Program

Select an infant car seat.
Select a toddler car seat.

Select a rental car equipped for a physically
challenged driver. You then choose either:
Left Hand Controls
Right Hand Controls

Select a car equipped with a mobile phone.
Select a car with a ski rack, snow tires, etc.

Select the frequent flyer program you want to
associate with rental cars. When you reserve a
rental car and the primary traveler's profile

includes an associated frequent flyer program for

rental cars, United Connection will forward the
primary traveler's membership number to the

rental car company. If the selected frequent flyer

program has a promotional agreement with the
rental company, the primary traveler may be
eligible for any benefits offered under that
promotion.

the traveler's hotel preferences.

3. To continue entering profile information, select the Hotel tab and enter
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Specifying hotel preferences

Hotel preferences include preferred hotel chains, preferred occupancy,
preferred amenities, preferred rate category, acceptable rate range, and most
important preference. If you choose the Use Preferences option in the
Select Hotel dialog box, United Connection will use the primary traveler's
hotel preferences to narrow the search for hotels.

To specify hotel preferences:

1. In the Trip Profiles dialog box, select the Hotel tab.

Trip Profiles

Traveler: Mr Stephen Crawford
Profile Mame: |Business Trips |

Flight | Flight Fequests | Car | Car Requests Hatel Fequests |

Preferred Hotel Chains Preferred Rate Category

|<None> j| | Standard j|

|<N0ne> j| Acceptable Rate Range

|<N0ne> j| ™ Search Within Price Range
Highest B ate: l:l

Preferred Dccupancy: Double j [T, D

(Pirslisen Smentiss Fiates for LS. locations only

F:g;z::::gnlng = Which iz most important to you?

[ Barber & Hatel Chain

[ Beauty Shop " Room Rates

[ Cable T - " Amerities

Trip Profiles dialog box, Hotel tab
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2. Enter the traveler’s hotel preferences as follows:

In this field

You can

Preferred Hotel
Chains

Preferred
Occupancy

Preferred
Amenities

Preferred Rate
Category

Search Within
Price Range

Which Is Most
Important To You

Select the traveler’s three preferred hotel chains.
The default is None.

Select Single or Double occupancy.

Select up to eight amenities (health club, meeting
rooms, baby-sitting, pool, etc.).

Select one of the following options: Standard,
Corporate, Senior Citizen, Club Level, or
Weekend. The default is Standard.

Select this option if you only want to see hotels
that offer rates within a price range you specify.
Then, do the following:

a. In the Highest Rate field, enter the highest rate
(per night) you want to pay for a room.

b. In the Lowest Rate field, enter the lowest rate
(per night) you want to pay for a hotel room.

Select the preference that is most important to the
traveler when searching for a hotel. Options are
Hotel Chain, Room Rates, or Amenities. The
default is Hotel Chain.

United Connection will try to find hotels that
meet all of the specified preferences. However, a
higher priority is placed on finding hotels that
meet the Most Important preference.

3. To continue entering profile information, select the Hotel Requests tab
and enter the traveler's hotel service requests.
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Specifying hotel service requests

Unfies] Commaciion Hotel services include guarantee for late arrival, additional guests in room,

cannot guarantee additional beds/cribs in room, and associated frequent flyer program. Hotel
hotel service service requests are forwarded for the primary traveler only.
requests. Please
call the hotel To specify preferred hotel services:
directly to confirm ) ] .
your requests. 1. In the Trip Profiles dialog box, select the Hotel Requests tab.
Trip Profiles
Traveler: Hr Stephen Crawford

Profile Name: |Business Trips |

If you select this Flight | Flight R equests | Car | Car Requests | Hotel
Optlon, a Cr_edlt Card Additional Service Requests
WI” be reqUIred to I~ Guarantes room for late arival
guarantee the room.

Nurnber of:
Additional Adults in Roam: mg

Addtional ChikheninRoom: [0 4]
Rall-&way Beds Required: mE
Cribzs Fequired: mg

fissaniated Erequent Flien Brogran:

| o

Trip Profiles dialog box, Hotel Requests tab
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*These options
apply to double-
occupancy rooms
only. Do not
include the first
two occupants.

2. Enter the traveler’s hotel requests as follows:

In this field

You can

Guarantee Room
For Late Arrival

Additional Adults
In Room*

Additional
Children In Room*

Roll-Away Beds
Required

Cribs Required

Associated
Frequent Flyer
Program

Select this option to hold the room regardless of
your arrival time. You will need to provide a
credit card when you reserve the itinerary.

Specify the number of additional adults that will
be sharing the room.

Specify the number of additional children that
will be sharing the room.

Specify the number of additional beds required.

Specify the number of cribs required.

Select the frequent flyer program you want to
associate with hotel reservations.

When you reserve a hotel room and the primary
traveler's profile includes an associated frequent
flyer program for hotels, United Connection will
forward the primary traveler’'s membership
number to the hotel. If that frequent flyer
program has a promotional agreement with the
hotel, the primary traveler may be eligible for
any benefits offered under that promotion.

3. When you have finished entering profile information, click OK to return

to the Traveler Editor dialog box.
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Changing Traveler Information

Follow these steps to update information for a traveler, such as phone
number, address, credit card information, or travel clubs.

To change traveler information:

1.

From the Tools menu, choose Traveler Editor. The Traveler Editor
dialog box displays a list of travelers and their profiles.

Select the traveler whose information you want to change, then click
Edit. The Traveler Information dialog box displays the Personal tab for
the selected traveler.

Select the tab that contains the information you want to change.

Select this tab To change the following information

Personal Traveler name, phone number(s), traveler type,
and home airport.

Payment Credit card type, account number, expiration
date, billing address.

Travel Programs Travel program name, account number, sponsor
type, and sponsor name.

Discount Programs Discount program name, account number,
sponsor type, and sponsor name.

Make the necessary changes. Refer to the online Help for detailed
information and instructions on changing these options.

When the changes are complete, click OK to return to the Traveler
Editor dialog box.

To return to the Itinerary Window, click Close.
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Deleting a traveler

You might want to delete a traveler from the Traveler Editor if you will no
longer be including that traveler in your itineraries.

To delete a traveler and all associated profiles:

1. From the Tools menu, choose Traveler Editor. The Traveler Editor
dialog box displays a list of travelers and their profiles.

2. Select the traveler that you want to delete, then click Delete. The
traveler's name and all associated profiles are removed from the list.

3. To return to the Itinerary Window, click Close.

Changing Profile Information

Follow these steps to update a traveler’s flight, rental car, or hotel
preferences and service requests.

To change profile information:

1. From the Tools menu, choose Traveler Editor. The Traveler Editor
dialog box displays a list of travelers and their profiles.

2. In the Travelers and Profiles list, select the profile that contains the
preferences or service requests you want to change.

3. Click Edit. The Flight tab of the Trip Profiles dialog box appears.

4. Select the appropriate tab as follows:

Select this tab To change

Flights Preferred airlines, preferred service class,
acceptable fare restrictions.

Flight Requests Preferred seating, preferred meal, special
services (such as a wheelchair at the airport).

Car Preferred rental companies, preferred car types,
acceptable rate range, in-terminal facilities,
unlimited mileage option.

Car Requests Infant/toddler car seats, car phone, ski-equipped
car, hand controls.

Hotel Preferred hotels, occupancy, amenities, rate
category, acceptable rate range.

Hotel Requests Late arrival guarantee, additional guests in hotel
room, extra beds or cribs.
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When you delete a
profile, the traveler
information and
other profiles
associated with that
traveler remain
unchanged.

. Make the necessary changes. Refer to the online Help for detailed

information and instructions on changing these options.

When the changes are complete, click OK to return to the Traveler
Editor dialog box.

. To return to the Itinerary Window, click Close.

Deleting a profile

If you have a profile that you do not intend to use again, you can delete it
from the Traveler Editor.

To delete a profile:

1.

From the Tools menu, choose Traveler Editor. The Traveler Editor
dialog box displays a list of travelers and their profiles.

Select the profile that you want to delete.

Click Delete. When prompted, verify that you want to delete the
selected profile. The profile is removed from the list.

To return to the Itinerary Window, click Close.



Creating and Managing Itineraries

In this chapter, you will learn how to:

Create an itinerary

Chapter

Select travelers
Save an itinerary
Open an itinerary
Change an itinerary
Cancel an itinerary

Delete itinerary files

About creating and managing itineraries

When you create an itinerary, the first thing you need to do is select the
travelers you want to include in that itinerary. You select from the list of
travelers and profiles you entered in the Traveler Editor.

Next, you plan your travel. As you select flights, rental cars, and hotel
accommodations, the ltinerary Window is updated with the information
related to your selections. This includes dates and times, locations, and
status (Planned, Reserved, etc.) for each item in your itinerary.

After you create an itinerary, you save the itinerary file on your computer
so that you can open it again at a later time. You may also change or
cancel an itinerary, although certain restrictions apply once the itinerary
has been reserved and you have received your ticket.

If you wish, you can print a copy of your itinerary to have on hand, or
even copy the information into another Windows application. See Chapter
11, Other Options, for more information about these features.
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A profile is preceded
by a suitcase icon.

Click Traveler
Editor to identify
new travelers or
change information
for an existing
traveler.

Creating a New ltinerary

To create a new itinerary, do one of the following:

Start United Connection. A new itinerary automatically appears in the
[tinerary Window. The default name is ITINT.ITN

If you are working on an itinerary and want to create a new itinerary,
choose New from the File menu. United Connection will close the
current itinerary and open a new one. If you have not saved changes to
the current itinerary, you will be prompted to do so.

Selecting Travelers

Before you select flights, rental cars, or hotel accommodations for your
itinerary, you need to select the travelers who will be included in the trip.
You can select up to four travelers for each itinerary.

You also specify one traveler as the primary traveler. When you choose
flights, cars, and hotels, United Connection can use the primary traveler's
preferences to customize the search.

To select travelers for an itinerary:

1.

From the toolbar in the Itinerary Window, choose the Travelers icon.
The Select Travelers dialog box appears.

The Travelers And Profiles list displays the names and profiles of all
travelers included in the Traveler Editor.

To select a traveler, click one of traveler's profiles.

The traveler's name and profile appear in the Travelers And Profiles For
This Itinerary list. Repeat this process for each traveler you want to
include in your itinerary.

Select Tiavelers

Travelers and Profiles: Travelers and Profiles for this ltinerany:

€ Mr Stephen Crawford Mr Stephen Crawford
L ] Business Trips

oK

Cancel

Traveler Editor Remove |

Frirnary Traveler:
Choose Traveler Editar to add

travelers or change profiles. | Mr Stephen Crawford j|

Select Travelers dialog box
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You will not be
able to reserve
your seats through
United Connection
if your itinerary
includes more than
one infant who will
be sharing a seat.
Safety guidelines
require that you
contact the airline
directly for your
seat assignments.

3. Inthe Primary Traveler field, select the traveler you want to designate as
the primary traveler. United Connection will then do the following:

If you select Use Preferences when choosing flights, cars, and
hotels, the primary traveler's preferences are used as the default.

If seat maps are not available for your flights (or you choose not to
use them), the primary traveler's seating preference is forwarded to
the airlines. All other travelers are seated in adjacent or nearby seats.
For cars and hotels, only the primary traveler's service requests and
travel program or discount program IDs (if applicable) are forwarded.

4. To return to the Itinerary Window, click OK. The names of the selected
travelers appear in the Travelers list.

Seating options for infants

Two seating options are available for infants (under the age of 2):
Reserving a seat for the infant.
Having the infant share a seat with a parent or guardian. Note that each
adult can share a seat with only one infant.

When you choose an infant traveler (under the age of two), a Sharing
Seat With Adult check box appears next to the infant's name. Check this
box if you want the infant to share a seat with a parent or guardian. If you
do not select the Sharing Seat With Adult option, you will need to
purchase a seat for the infant.

You can change an infant's seating arrangement by selecting or de-
selecting the Sharing Seat With Adult option in the Select Travelers
dialog box. However, doing so will make it necessary to re-select all your
flights. To change an infant's seating option after your itinerary has been
ticketed, please contact the airline directly.

Adding Flights, Cars, and Hotels

After selecting travelers for your itinerary, you are ready to begin adding
flights, rental cars, and hotel accommodations. Refer to:

Chapter 6, Selecting Flights
Chapter 7, Selecting Rental Cars

Chapter 8, Selecting Hotel Accommodations



58 United Connection User Manual

All United
Connection
itinerary files must
have the file
extension ITN. If
you do not enter
this extension,
United Connection
will append it
automatically.

Saving an Itinerary

You must save all itineraries you want to retrieve at a later time. When you
save an itinerary, United Connection stores the itinerary file on your
computer. If you make any changes to the current itinerary, you will be
prompted to save those changes before opening a new itinerary or exiting
United Connection.

To save an itinerary using the existing name:
From the File menu, choose Save.

If you have not already saved the current file, the Save As dialog box
appears. If you have already saved the current itinerary, the file will be
saved automatically using the existing name.

To save an itinerary using a new name:

1. From the File menu, choose Save As. The Save As dialog box appears.
The File Name list displays all itinerary files in the United Connection
directory (the one created during installation).

[tinerary files are saved in this directory by default. If you wish, you can
save the file to a different drive and/or directory.

2. In the File Name field, enter a name for the current itinerary file. The
default name is ITINT.ITN.

3. Click OK to save the current itinerary using the specified file name. The
itinerary name is displayed in the title bar of the Itinerary Window.

Note: Once you reserve an itinerary, we strongly recommend that you do not
create copies of that itinerary using the Save As option. A reserved itinerary
exists in two places: on your computer, and in United Airlines' reservation
system. If you have more than one copy of a reserved itinerary on your
computer, all copies will remain linked to the same file in the reservation
system and changes made in one file will be reflected in all others.

Opening an ltinerary

You open an itinerary by opening the corresponding itinerary file stored on
your computer. United Connection itinerary files are saved with the file
extension ITN. By default, these files are stored in the United Connection
directory which was created during installation.
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When you open a reserved itinerary, United Connection needs to update
the itinerary by retrieving information from the reservation system. If you
are already connected to the reservation system, United Connection
updates the itinerary automatically. If you are not connected, you will be
prompted to do so. Note that the local copy of a reserved itinerary will be
read-only until you update it by connecting to the reservation system.

To open an itinerary:

1. From the File menu, choose Open. The Open dialog box appears.

United Connection itinerary files have the file extension ITN. The File
Name list displays all itinerary files in the current directory.

2. If you see the itinerary you want to open, select that file. The selected
file name appears in the File Name edit field.

3. If you do not see the itinerary you want to open, you can change drives
and/or directories to display other itinerary files.

4. After selecting an itinerary file, click OK to open that itinerary. The
selected itinerary appears in the ltinerary Window.

Note: If necessary, you can open a reserved itinerary directly from the
reservation system by selecting the Retrieve From Reservation System
option from the File menu. This enables you to view your reservation even if
the itinerary file does not exist on your computer system. See "Retrieve from
Reservation System" in Chapter 11 for more information.

Opening itineraries on different systems

Itinerary files can be copied from one computer to another. However, these
files are subject to restricted access once they are reserved.

Before you reserve an itinerary, you can view and edit the itinerary using
any computer on which United Connection is loaded simply by copying
and opening the file. Reserved itineraries can be viewed on another
person's system, but not updated or modified. Once you reserve your
itinerary, that itinerary can only be updated and modified using the system
on which it was created (or on another system registered to the same user).

This restriction is imposed by the reservation system in order to ensure the
privacy of your travel plans. The same restriction applies to the Retrieve
From Reservation System option. When you choose this option from the
File menu, the reservation system displays only itineraries created on the
current system (or on another system registered to the same user).
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Changing an Itinerary

Before an itinerary is reserved, you can make any changes you wish without
incurring a service charge. This includes adding, deleting, or modifying
flights, rental cars, and hotel rooms, or changing service requests. Once an
itinerary has been reserved, certain restrictions apply (as described below).

Agency itineraries: If you chose to pick up your ticket at your preferred
Apollo travel agency, you will not be able to modify or cancel the itinerary
through United Connection once it has been reserved. To make any
changes to this type of itinerary, please contact your travel agency directly.

Changing travelers in an itinerary

If you add or remove travelers in an itinerary, you will need to re-select all
of your flights, rental cars, and hotel rooms. For this reason, we
recommend that you do not begin selecting itinerary items until you have
finalized the list of travelers for that itinerary.

Once your itinerary has been reserved, you will not be able to add or
remove travelers through United Connection. To change travelers in a
reserved itinerary, please contact the airline directly.

To change travelers in an itinerary:

1. From the File menu, choose Open and select the itinerary in which
you want to change travelers.

2. From the toolbar, choose the Travelers icon.

A message warns you that you will need to re-select all flights, rental
cars, and hotels, and prompts you to confirm your decision. When you
do so, the Select Travelers dialog box appears.

3. Toremove a traveler, highlight that traveler's name in the Travelers
And Profiles For This Itinerary list, then click Remove.

4. To add a traveler, highlight the profile you want to use for that traveler
in the Travelers and Profiles list.

5. To return to the Itinerary Window, click OK. Note that the status of all
itinerary items is now Planned.

6. Re-select each planned flight, rental car, and hotel room.
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You will not be
able to change
flight reservations
under certain
conditions. See
"Restrictions on
changing and
canceling flights"
in the online Help
for more
information.

Changing flight reservations

Before an itinerary is ticketed, you can change or delete flights in that
itinerary without incurring a service charge or cancellation penalty. If you
make a change that affects the current airfare, United Connection will
automatically display the new airfare in the Itinerary Window. Remember
that your airfare is not guaranteed until you pay for your ticket.

Once the itinerary is ticketed, the following conditions apply:

Changing or canceling flights in a ticketed itinerary may result in a fare
difference and/or service charge. Contact the issuing airline for details.

United Connection cannot reprice a ticketed itinerary. To get a revised
fare you will need to contact the issuing airline directly.

After changing a ticketed itinerary, you will need to exchange your
ticket. You may contact the issuing airline, or take your ticket to a
United Airlines airport ticket office or city ticket office for exchange.

To change a flight:

1.
2.

® N o Uk

Open the itinerary you want to change.

In the Itinerary Window, double-click on the flight you want to change.
The Edit Flight dialog box appears.

This dialog box displays the flight planning information you entered for
that flight, along with the airline and flight number, departure and
arrival information, and service class.

If you wish, you can edit the Plan Information displayed at the top of
the dialog box to choose a different origin, destination, date, or time.

To find available flights, click Find Flights.

To view or edit flight service requests, click Requests.

To view flight details, click Details.

To save your changes and return to the Itinerary Window, click OK.

If you have made changes to a reserved itinerary, you will need to re-
reserve that itinerary. See Chapter 9, Reserving Your Itinerary.
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To cancel the
entire itinerary,
choose the
Cancel icon from
the toolbar. See
"Canceling a
Reserved Itinerary"
later in this chapter
for more
information.

To delete a Planned or Selected flight:

1.

2
3.
4

Open the itinerary that contains the flight you want to delete.
In the Itinerary Window, highlight the flight to be deleted.

From the Edit menu, choose Delete (or simply press the [Delete] key).

. To save your itinerary, choose Save from the File menu.

To delete (cancel) a Reserved or Ticketed flight:

1.

2
3.
4

U1

Open the itinerary that contains the flight(s) you want to cancel.
In the Itinerary Window, highlight the flight to be canceled.

From the Edit menu, choose Delete (or simply press the [Delete] key).

. Choose the Reserve icon from the toolbar. The Pricing Summary

dialog box appears.
Review the itinerary, then click Reserve.

If the itinerary has not yet been ticketed, you will need to re-select a
ticketing option and credit card.

In the Confirm Reservation dialog box, click Finish to send the revised
itinerary to the reservation system. When the Confirmation dialog box
appears, click OK to return to the Itinerary Window.

If the itinerary was already ticketed, you need to contact the issuing
airline to request a new ticket, or take your ticket to a United Airlines
airport ticket office or city ticket office for exchange.
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Changing rental car reservations

Before you reserve an itinerary, you can modify or delete any Planned or
Selected rental car in that itinerary. Once you reserve a car, you must
contact the rental company directly if you want to change your reservation.
However, you may still cancel that reservation through United Connection.

To change a Planned or Selected rental car:

1. Open the itinerary that contains the rental car you want to change.

2. In the ltinerary Window, double-click on the rental car to be changed.
The Edit Car dialog box appears.

This dialog box displays the rental car planning information you
entered. If a rental car has been selected, it also displays the rental
company, car type, and rate.

3. If you wish, you can edit the Plan Information displayed at the top of
the dialog box.

. To find rental companies with available cars, click Find Cars.
. To view or edit service requests for a Selected car, click Requests.

4
5
6. To view rental car company details for a Selected car, click Details.
7. To return to the Itinerary Window, click OK.

8

. To save your itinerary, choose Save from the File menu.

To delete a Planned or Selected rental car:

1. Open the itinerary that contains the rental car you want to delete.

2. In the ltinerary Window, highlight the rental car to be deleted.

3. From the Edit menu, choose Delete (or simply press the [Delete] key).
4

. To save your itinerary, choose Save from the File menu.
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Canceling a reserved rental car

Follow these steps to cancel a rental car reservation that you made through
United Connection. Cancellation fees may apply. For more information
about rental company cancellation policies, display the Details dialog box
for that rental car or contact the rental company directly.

To cancel a reserved rental car:

1. Open the itinerary that contains the rental car you want to cancel.

2. In the ltinerary Window, highlight the rental car to be canceled.

3. From the Edit menu, choose Delete (or simply press the [Delete] key).
4

. Choose the Reserve icon from the toolbar. The Pricing Summary dialog
box appears.

63}

Review the itinerary, then click Reserve.

6. In the Confirm Reservation dialog box, click Finish to send the revised
itinerary to the reservation system. When the confirmation dialog box
appears, click OK to return to the Itinerary Window.

Changing hotel reservations

Before you reserve an itinerary, you can modify or delete any Planned or
Selected hotel room in that itinerary. Once you reserve a hotel room, you
must contact the hotel directly if you want to change your reservation.
However, you may still cancel that reservation through United Connection.

To change a Planned or Selected hotel room:

1. Open the itinerary that contains the hotel room you want to change.

2. In the ltinerary Window, double-click on the hotel room to be changed.
The Edit Hotel dialog box appears.

This dialog box displays the hotel planning information you entered. If
you have selected a hotel room, it also displays the hotel name, address,
phone number, and rate.

3. If you wish, you can edit the Plan Information displayed at the top of
the dialog box.

4. To find hotel with available rooms, click Find Hotels.
5. To view or edit service requests for a Selected hotel, click Requests.

6. To view hotel details for a Selected hotel room, click Details.
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7. To return to the Itinerary Window, click OK.

8. To save your itinerary, choose Save from the File menu.

To delete a Planned or Selected hotel room:

—_

. Open the itinerary that contains the hotel room you want to delete.

In the Itinerary Window, highlight the hotel room to be deleted.
From the Edit menu, choose Delete (or simply press the [Delete] key).

To save your itinerary, choose Save from the File menu.

Canceling a reserved hotel room

Follow these steps to cancel a hotel reservation that you made through

United Connection. Cancellation fees may apply. For more information
about hotel cancellation policies, display the Details dialog box for that
hotel room or contact the hotel directly.

To cancel a hotel reservation:

1.

u1

Open the itinerary that contains the hotel room you want to cancel.

2. In the ltinerary Window, highlight the hotel room to be canceled.
3.
4

From the Edit menu, choose Delete (or simply press the [Delete] key).

. Choose the Reserve icon from the toolbar. The Pricing Summary dialog

box appears.
Review the itinerary, then click Reserve.

In the Confirm Reservation dialog box, click Finish to send the revised
itinerary to the reservation system. When the confirmation dialog box
appears, click OK to return to the Itinerary Window.
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If you do not pay
for your ticket
online and do not
pick up your ticket
by the ticketing
deadline, the
reservation system
will cancel your
itinerary
automatically.

You can reinstate a
canceled itinerary
at any time prior to
the departure of
the first flight —
please call United
Airlines
Reservations for
assistance.

Canceling a Reserved Itinerary

United Connection lets you cancel a reserved itinerary at any time, with a
few exceptions. You cannot cancel a reserved itinerary if:

You chose to pick up your ticket at your preferred Apollo travel agency.
Please contact your travel agency directly.

The itinerary is in the process of being ticketed.
Certain pricing modifications have occurred in the reservation system.

A message will appear if you attempt to cancel a itinerary that cannot
be canceled.

Warning: Potential charges and refund restrictions may apply if you cancel a
ticketed itinerary. Please refer to the Notices area of the Itinerary Window, or
contact the issuing airline for more information.

To cancel a reserved itinerary:
1. Open the itinerary you want to cancel.
2. From the toolbar in the Itinerary Window, choose the Cancel icon.

3. A message warns you that continuing will cancel all items (flights,
rental cars, and hotel rooms) in your itinerary.

4. To cancel the itinerary, click Yes. The status of all items in the itinerary
changes to CANCELED, and the message "ltinerary has been canceled"
appears in the Notices area of the Itinerary Window.

Deleting Itinerary Files

When you save an itinerary, United Connection stores the itinerary file on
your computer using the file extension ITN. By default, itinerary files are
stored in the United Connection directory created during installation.

You should maintain a reserved itinerary file until after the last travel or
reservation date associated with that itinerary. Once travel is complete, you
can delete the itinerary file using the Windows File Manager (or whatever
method you normally use to remove files from your system).

Note: If you delete a reserved itinerary file from your system before travel has
begun, you can retrieve a copy of that itinerary from the reservation system.
See "Retrieve From the Reservation System" in Chapter 11 for details.




Chapter

Selecting Flights

In this chapter, you will learn how to:
Select flights based on schedule
Select flights based on fare using FareShopper™ and SuperShoppers™
Apply or change flight preferences
Request flight services

Select seats for United and United Express flights using a seat map

How do | get started?

When you want to add a flight to your itinerary, the first thing you need to
do is enter planning information for that flight. Planning information
includes origin, destination, departure date, and departure time. After you
enter this information you're ready to select a flight.

p— Note: To begin selecting flights immediately, click the
Add Flight icon in the toolbar. The Plan Flight dialog

ﬁ box appears. (If you have not selected travelers for your
itinerary, do this first by clicking the Travelers icon.)

United Connection gives you two ways to select flights:

Based on schedule — choose flights that depart and arrive when it’s
most convenient for you.

Based on fare — use FareShopper to find an acceptable fare, then
select from flights available at that fare.

If fare is not an issue, simply choose the flights you want from a list of
available flights. United Connection quotes a fare for those flights based on
the service class and fare restrictions you specify.

If getting a low fare is important, use FareShopper. United Connection
finds a range of low fares for your itinerary and displays flights offered at
that fare. Use SuperShopper to extend your search over a range of days.
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Selecting a Flight Based on Schedule

When you select a flight based on schedule, you will:
Enter flight planning information
View available flights, then select the flight that meets your needs

Review and/or edit flight service requests

To plan a flight:

1. In the Itinerary Window, choose the Add Flight icon from the toolbar.
The Add Flight dialog box appears.

If the From flelq is blank Add Flight = sk on the
or incorrect, edit the - : p— .

i ' 2n nformation arrows to display
primary traveler S From: |J0hn F Kennedy Intl [Mew York, MY u H
personal information and = - I the airport
enter a home airport. To |L03Angeles|nt| [Los Angeles, Ca) u search control.

Cancel

To select flights

_Find Fighis | based on your
Mo flight has been selected. Tafind a flight, enter y .
wour planning information. Then, choose the Find Hequests SChedUle, click

Flights button. Find Flights.

Flight Selection

Add Flight dialog box

2. Complete the Add Flight fields as follows:

In this field You can

From Enter or select the departure city/airport.

The primary traveler's home airport is supplied
by default for the first flight in the itinerary.

To Enter or select the destination city/airport.
Date Enter or select the departure date.
Time Enter or select your preferred departure time.

United Connection searches for flights that
depart up to 30 minutes before the time you
specify, as well as flights at or after that time.
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A dash indicates that
seating is not available
in that class. For
example, -BC indicates
that First class is not
available.

To display flights based
on the primary
traveler's flight
preferences, select Use
Preferences. Click
Edit to change these
preferences for the
current flight.

If none of the
flights meets your
needs, you can
modify the list by
changing flight
preferences. See
“Changing the List
of Available
Flights” later in this
chapter.

3. Click Find Flights. The Select Flight dialog box appears.

To select a flight:

1. In the Select Flight dialog box, review the list of available flights.
Flights are sorted by number of stops (first non-stops, then 1-stops,
etc.), then by time. Click More Flights to display additional flights.
Select Flight [ %]

Flight Information F

Flight ‘ Time | Location \lEIass| Meal| Infarmation o

Tower i 08:00a Jahn F Kennedy Intl [Mew... - BC Yes Mon-stop. No On Time Data i
FF 0021 10:45a Loz Angeles Intl [Los Angel... 747

Thalh, 08:00a Jahn F Kennedy Intl [Mew...  FBEC ‘Yes Mon-stop. 20% On Time.
Tw! 0015 Los Angeles Intl [Las Angel 767,
Ad 0033 Loz Angeles Intl [Los Angel... AB3 Details
“Lantas ... John F Kennedy Intl (MewY... FBC Yes Mon-stop. No On Time Data Bt

0OF 0332 : Los Argeles Intl [Los Argel.. 4873 Restricted. Code Share (i
United : Jahn F Kennedy Intl [Mew...  FEC ‘Yes Mon-stop. B0% On Time.

Ua 0978 Loz Angeles Intl [Los Angel... 767, b

American Jahn F Kennedy Intl [Mew...  FBEC ‘Yes Mon-stop. 40% On Time.

Ad 000 Loz Angeles Intl [Los Angel... 763

United : Jahn F Kennedy Intl [Mew...  FEC ‘Yes Mon-stop. 70% On Time.

ua o017 Loz Angeles Intl [Los Angel... 767,

American Jahn F Kennedy Intl [Mew...  FEC ‘Yes Mon-stop. B0% On Time.

Ad 0019 Loz Angeles Intl [Los Angel... 767,

United 12:00p Jahn F Kennedy Intl [Mew...  FEC ‘Yes Mon-stop. 70% On Time. =
Flight Plan

Fram:  John F Kennedy Intl New Yark, NY) Use Preferences Edit

Ta: Los Angeles Intl [Los Angeles, CA) —

Daie: DR/ Tine: DG O0a I ncude EullFights

Select Flight dialog box
To change preferences for
this flight, click Edit.

2. To view operation and service details for a flight, highlight that flight
and click Details. The Flight Details dialog box appears. Click Close
to return to the Select Flight dialog box.

3. To print the list of available flights, click Print.

4. If you select a United Airlines or United Express flight, you can use the

seat map to select specific seat assignments for that flight.

Click Seat Map, then select seats for all travelers in your itinerary.
When you are finished selecting seats, click OK. For more information,
see “Selecting Seats Using the Seat Map” later in this chapter. If you
selected your seats from the seat map, proceed to step 7.

Click OK to select the highlighted flight. The Confirm Service Class
dialog box appears.
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If seating cannot be
assigned, “Available
at Airport” is
displayed.

If you do not want to
display this dialog
each time you select a
flight, click in this box
to remove the check.

Confirm Service Class

Please select the desired service class
far this Hlight.

-

" Coach Class E

Confirm Service Class dialog box

6. Select a service class for this flight and click OK. The Flight Service

Requests Summary dialog box appears.

Flight Service Requests Summary

Flight S ervices For:

Flight S egment
John F K

| I it Tiogether fefare [Hia Seat Map

¥ Shaow this surmmary after each flight selection

Flight Service Requests Summary dialog box

View and/or edit the flight services for each traveler. For more
information, see “Requesting Flight Services” later in this chapter.

When you are satisfied with the service requests, click OK. United
Connection asks if you want to add another flight. Respond Yes or No.
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The airfare for your
itinerary is displayed in the
Totals area. This airfare is
not guaranteed until you
pay for your tickets.

The flights you selected are

o SELECTED | |
added to the Itlnlerary' The J— W Urited 0020 Class: Business
status of each flight should Fri  0G/06/97 07:00a Los Angeles Irtl [Los bngeles, C4)  Seat; Requested
be SELECTED. GENEET Fi  OR/DE/97 03:14p John F Kenredy Inf [New Yark_ N
Ready |'wed 09/04/96 10:12p | ={I3=Cornected v

Updated Itinerary Window

An example of the Itinerary Window that includes a round-trip flight
between New York and Los Angeles is shown below.

# Itinl.itn - United Connection

File Edit Yiew ltnerary Tools Help

ITINERAR

Travelers Totals Notices
tdr Stephen Crawford Flight Cost: $2101.00 USD
Car E stimate: 1]
Hotel Estimate: 1]
WP Flight Miles: 4350

Status Date/Time Location

Sample Itinerary Window showing selected flights

About connection times...

Adequate connection time is automatically built-in to all connecting flights
displayed by United Connection. If you create your own connecting flights,

you must leave at least 60 minutes between flights (90 minutes for

connections to or from international locations) to allow adequate time to

change planes. If you select a flight that does not adhere to these guidelines

you will not be able to add it to your itinerary.
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You cannot use
FareShopper to
reprice or rebook a
ticketed itinerary.

Selecting Flights Based on Fare

FareShopper is a service provided exclusively by United Airlines to help
you quickly find low fares for a specified itinerary. Use this option if your
schedule is flexible, and if finding a low fare is more important than arriving
or departing at a specific time. FareShopper also includes the SuperShopper
option, which allows you to extend your search for low fares over a full 24-
hour period, or even over a range of days.

You begin by entering basic planning information for each flight in your
itinerary — including origin, destination, and departure date and time.

When you choose the FareShop icon from the toolbar,
FareShopper searches the reservation system for available
low fares based on the information you provided, then
displays a list of these fares.

Choosing a fare

For each fare, United Connection shows you the airlines offering that fare
and the applicable fare restrictions — for example, minimum or maximum
stay requirements, purchasing deadline, change fees, and refundability.
Lower fares usually have more restrictions than full-price fares.

Using SuperShopper

If your schedule is flexible, use the SuperShopper option to search for low
fares over a full-24-hour period (midnight to midnight on the dates you
selected). You can even extend this search over a range of days — up to
two days before and after your planned travel dates. Note that this option is
only available for itineraries of one or two segments.

Choosing flights

After you choose a fare, United Connection displays the flights available at
that fare. You can view flight details, view and edit service requests, and
select seats using a seat map (on United and United Express flights). A
separate tab appears for each day of the week. If you used SuperShopper to
search over a range of days, more than one day may be available.
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Using FareShopper
When you select flights using FareShopper, you will:
Enter flight planning information for each flight.
Choose the FareShop icon from the toolbar.
View a list of fares for your itinerary, then select a fare.
If you wish, use the SuperShopper option to extend your search.

View available flights to each destination in your itinerary, then select
the flights that meet your needs. Note that if you selected a low fare with
multiple restrictions, a limited number of flights may be available.

Review and/or edit flight service requests for each flight.

To plan a flight:

1. In the Itinerary Window, choose the Add Flight icon from the toolbar.
The Add Flight dialog box appears.

If the From field is blank Add Flight
or incorrect, edit the
primary traveler's personal
information and enter a

Click on the
arrows to display
the airport search

Plan Information

Erom: \ |John F Kennedy Intl [Mew York, M)

. Tao Loz Angeles Intl [Los Angeles, CA) control.
home airport. | -
Drate: 06/02/97 Time: (06:00 AM =
(05102757 [peo0 M —
Flight Selection
Find Flights If you want to use

Mo flight has been selected. To find a flight. enter .
your planning infarmation. Then, choose the Find FareShODDer, click

Flights buttan. OK to add the

flight to your
itinerary in

PLANNED status.

Add Flight dialog box
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2. Complete the Add Flight fields as follows:

In this field You can

From Enter or select the departure city/airport.

The primary traveler's home airport is supplied
by default for the first flight in the itinerary.

To Enter or select the destination city/airport.
Date Enter or select the departure date.
Time Enter or select your preferred departure time.

United Connection searches for flights that
depart up to 30 minutes before the time you
specify, as well as flights at or after that time.

3. Click OK.

4. United Connection prompts you to add another flight. Choose Yes to
add another flight, or No if you have finished your flight planning.

To select a fare in FareShopper:

1. After planning all your flights, choose the FareShop icon from the

If the status of one toolbar. The Select FareShopper(sm) Fares dialog box appears.
or more flights in
the Itinerary Select FareShopper[sm) Fares
Window is Available Fares and R
Selected, a Min | Max | Purchaze | Mon- Outbound -
! Fare Stay | Stay | By Fiefundable Cariers Inbound
message warns that $1507.00 N N 0307796 N Urited Aifires Inc B VR
you will need to bl i
. $1501.00 M M 03/07/96 M American Ailines
reselect all flights e
using FareShopper. $150718 N N 03/07/9% N Diela Air Lines T
- F-
$157500 N M 09/07/9% N T Trans World irlines YRR
[ - il
0| |_’|_|

Changes to a ticketed itinerary may result in a fare difference =
and/or a service charge that will require you ta exchange the I Use Preferences Edit | ‘
ticket at a United Airlines airport ticket office or city ticket office.

Fare Restriction Details
The ticket is non-refundable.

Help | Cancel | 44 Fares | ¢ e | Next > I Finizh |

Select FareShopper(sm) Fares dialog box
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If none of the fares
meets your needs,
modify the list by
changing flight
preferences. See
“Changing the List
of Available Fares”
later in this
chapter.

A separate tab is
displayed for each
day of the week. If
you used
SuperShopper,
flights may be
available on more
than one day.

To view operation

and service details Flight Plan (1 of 2] |

for a flight,
highlight that flight
and click Details.

Fares are displayed from lowest to highest. Scroll down to view all of
the available fares. The days on which each fare is available appear in
the Outbound/Inbound column.

To see detailed fare restrictions for a particular fare, highlight that fare.
The associated fare restrictions appear at the bottom of the dialog box.

Note: Change fee information is not available for international flights.
Please contact the airlines directly to obtain this information.

If your schedule is flexible (and your itinerary includes no more than

two segments), click SuperShop to shop for low fares over a full 24-
hour period or over a range of days. See "Using SuperShopper" below
for more information.

Click Hints to see helpful information about FareShopper and
SuperShopper. A summary of the hints is provided later in this chapter.

To select a fare, highlight that fare and click Next>. The Select
FareShopper(sm) Flights dialog box appears.

To select flights in FareShopper:

1.

In the Select FareShopper(sm) Flights dialog box, review the list of
available flights to the first destination in your itinerary. The selected
fare is shown at the top of the dialog box.

Select Fare5hopper[zm]) Flights

FareShopper Flight Availability Flight choices limited to $1501.00 fare

Friday | Saturday | Sunday Monday | Tuesday | ‘wiednezday | Thurzday |
i Informatiaon
Ua 005 b
United FBC Yez Mon-stop
Ua 0976 11:5Babo Loz Angeles Intl [Los Angel 7E7T.
United 10:30a Mo John F Kennedy Intl [(Mew FBC Yesz Monstop. 70% On Time o
Ua 0017 01:20p Mo Los Angeles Intl [Los Angel 7B7.
United 12:00p Mo John F Kennedy Intl [Mew FBC Yesz Monstop. 70% On Time
Ua 0013 02:57pko Loz Angeles Intl [Los Angel 7E7T.
United 02450 Mo John F Kennedy Intl [(Mew FBC Yesz Monstop. 70% On Time
Ua 0003  05:49p ko San Francisco Intl Arpt [San 7E7.
United 0B 42p Mo 5an Francizco Intl Arpt [S an F-C Mo Monstop. 80X On Time LI
Details | Seat Map | FRequests |
Frarm: John F Kennedy Intl [Mew Yark, N
Ta: Loz Angeles Intl [Los Angeles, CA)
Date: 06/02/97 Time: 06:00a
Help | Cancel | << Fares | < Brew | Next > I Finish |

Select FareShopper(sm) Flights dialog box

This dialog box displays a list of available flights to the first destination
in your itinerary. A separate tab appears for each day of the week.
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If none of the
flights meet your
needs, click
<<Fares to return
to the Select
FareShopper(sm)
Fares dialog box
and select a
different fare.

If seating cannot be
assigned, “Available at
Airport” is displayed.

If you do not want to
display this dialog each
time you select a flight,
click in this box to
remove the check.

2.

If you used SuperShopper to search over a range of days, more than one
day may be available. Choose a tab to see the available flights for that
day. The tabs are disabled for days on which no flights are available.

To view operation and service details for a flight, highlight that flight
and click Details. The Flight Details dialog box appears. Click Close
to return to the Select FareShopper(sm) Flights dialog box.

If you selected a United Airlines or United Express flight, you can use
the seat map to select specific seat assignments for that flight.

Click Seat Map, then select seats for all travelers in your itinerary.
When you are finished selecting seats, click OK. For more information,
see "Selecting Seats Using the Seat Map" later in this chapter.

To see service requests for the selected flight, click Requests. The
Flight Service Requests Summary dialog box appears.

Flight Service Requests Summary

- 1

Flight Services For: | M1 Stephen Crawbord jl g
]

Cancel

= |5t Togetter foliare [t Seat Map Edi... I

IV Show this summary after each fight selection

Flight Service Requests Summary dialog box

View and/or change the flight services for each traveler. When you are
satisfied with the flight services, click OK. For more information, see
"Requesting Flight Services" later in this chapter.

When you are ready to select your next flight, click Next>. The Select
FareShopper(sm) Flights dialog box displays flights to the next
destination in your itinerary.

When you have selected all flights in your itinerary, click Finish> to
return to the Itinerary Window.

Note: If you wish, United Connection can automatically choose flights for you
in FareShopper. Simply click Finish in the FareShopper(sm) Flights dialog box,
then click Yes when prompted to continue. United Connection will select
flights closest to the departure times you specified.
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For helpful hints
about FareShopper
and SuperShopper,
click Hints in the
Select
FareShopper(sm)
Fares dialog box

Using SuperShopper

United Connection's SuperShopper feature extends the power of
FareShopper by allowing you to shop for low fares over a greater time
period. Normally, FareShopper looks for low fares within a limited time
window, based on the departure times you selected in the Plan Flight dialog
box. SuperShopper searches for low fares over a full-24-hour period, from
midnight to midnight on your planned departure dates. You can even
extend this search over a range of days — up to two days before and after
your planned travel dates. Note that the SuperShopper option is only
available if your itinerary includes no more than two segments.

To use SuperShopper:

1. In the Select FareShopper(sm) Fares dialog box, click SuperShop. The
SuperShopper(sm) dialog box displays a date range selector for each
flight, initially set to the planned date for that flight.

SuperShopper[sm) [ x|

Set the date ranges within which United Connection should search for Outbound and Inbound fights.
“f'ou can search up to bwo days before and after pour original dates. 3 !
p

Outbound Plan Inbaund Plan

0401 ‘ " 0B/03
06/02/97 0G/06/97

SuperShopper(sm) dialog box

2. To search over the full 24-hour period on your original planned dates,
click OK without changing the date controls.

3. You can also extend your search over a range of days:

a. Move the Outbound controls left and right to specify the date
range in which to search for outbound flights. You can set the
controls up to two days before and after the original departure date.

b. Repeat this process with the Inbound controls to specify the date
range in which to search for inbound flights. United Connection
searches the full 24-hour period for each day.

c. To begin searching for low fares, click OK.

Note: If SuperShopper is currently disabled, a message will be displayed.
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SuperShopper[sm] - Retnieving Fares

SuperShaopper iz requesting fares far the dates pou selected. This process
may take a few minutes.

Lowest fare found: $255.72
Searching for fares from: 06/02/97 to 06/0E/97

Retrieving Fares dialog box

. The lowest fare found so far during the retrieval process is displayed

under the status bar. This display is updated each time a lower fare is
found. When the retrieval process is complete, all available fares are
displayed in the Select FareShopper(sm) Fares dialog box.

To stop the retrieval process before it is finished, click Stop. The Select
FareShopper(sm) Fares dialog box displays the fares retrieved so far.

Note: Because SuperShopper is searching for low fares over a wide
selection of flights, retrieval time may be lengthy. Using a 14,400 baud
modem, the approximate retrieval time for a two-person itinerary can range
from 3 to 30 minutes, depending on the number of days you are searching.

Review the fares displayed in the Select FareShopper(sm) Fares dialog
box. The days on which each fare is available appear in the
Outbound/Inbound column.

. To choose a fare, highlighted that fare and click Next>. The Select

FareShopper(sm) Flights dialog box appears. See “To select flights in
FareShopper” above for more information.
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Shopping Hints

Should I use Flight Preferences? Yes. Selecting Use Preferences will
increase your chances of finding low fares on your preferred airlines.

How are flights displayed? Flights are sorted in the order of non-stops,
direct flights and connections. For the complete list of flights, be sure to
scroll down to view the entire list when choosing flights.

Can | request a specific service class? No, the Service Class preference is
ignored. FareShopper displays the lowest fares it can find, usually in Coach.

Finding a previous fare. Certain actions will cause the fare display to
update. If you change Flight Preferences, turn Preferences on or off, or
change your dates in SuperShopper and cannot find a previously displayed
fare, return that option to its previous setting and repeat the search.

Shopping for international itineraries. Flights from the U.S. to international
destinations often depart at a specific time of day. If you are traveling to an
international destination, you may have better luck finding available flights
if you enter the recommended departure time for that destination in the
Plan Flight dialog box. See “Shopping Hints” in the online Help for
recommended departure times to international locations.

Cities with multiple airports. For cities with multiple airports, be sure to
specify the exact airport you want to use in the Add Flight dialog box.

Change fees. Change fee information may not appear for international
flights when you highlight a fare. Please contact the airlines directly to
obtain change fee information.

How long will SuperShopper take? Because SuperShopper searches for low
fares over a wide selection of flights, retrieval time may be lengthy. Using a
14,400 baud modem, the approximate retrieval time for a two-person
itinerary can range from 3 to 30 minutes. Retrieval time is affected by:

Number of days you are searching (more days increase the search time)
Number of travelers in your itinerary (more travelers lengthen the search)
Time of day (try using SuperShopper during off-peak hours, 7PM to 7AM)
Selected cities (international itineraries usually take longer than domestic)
Flight Preferences (using Flight Preferences can reduce retrieval time)
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Updated Itinerary Window

An example of the Itinerary Window that shows a round-trip flight between
Chicago and San Francisco is shown below.

Help

The airfare for your

itinerary is displayed in the ' ' —— '
Totals area. This airfare is ITINERA R
t teed until vo Travelers Totals Notices
no guaran ee' unt y u tdr Stephen Crawford Flight Cost: $2101.00 USD
pay for your tickets. Car Estimate: 1]
Hotel Estimate: 1]
4P Flight Miles: 4350

Status

The flights you selected are
added to the itinerary. The
status of each flight should ~—
be SELECTED.

SELECTED
W Urited 0020 Class: Business
Fri  OB/0E/97 07:00= Loz Angeles Intl [Los Angeles, CA) Seat: Reguested
i Bam ARl Fri  OB/DB/97 03:14p John F Kennedy Intl [New York, NY)

Ready |'wed 09/04/96 10:12p | ={I3=Cornected i

Sample Itinerary Window showing the selected flights
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To use flight
preferences when
adding a flight to
your itinerary,
select Use
Preferences.

Changing Flight Display Options

If you don't immediately find a flight or fare that suits your needs, don't give
up! You can broaden your search to include different days or different
airlines, or focus your search by applying flight preferences. See below for
information on:

Changing flight preferences
Changing the list of available flights
Changing the list of available fares

Changing preferences for the current flight

At your option, United Connection can use flight preferences to narrow the
search for acceptable flights (in the Select Flight dialog box) or fares (in
FareShopper). Flight preferences include Preferred Airlines, Preferred
Service Class, and Acceptable Fare Restrictions. Flight preferences from the
primary traveler's profile are used as the defaults. If you wish, you can edit
these preferences on the fly as you add flights to your itinerary.

To change preferences for the current flight:

1. In the Select Flight dialog box or the Select FareShopper(sm) Fares
dialog box, click Edit. The Flight Preferences dialog box appears.

Click Update Profile to save the
changed preferences in the primary —

Click OK to use the X :
traveler’s profile.

changed preferences
for the current flight.

Flight Preferences

Using Primary Traveler's Preferences: kr Stephen Crawford [Business Trips]

Flight |
Pieferred Airlines A ptable Fare B
[ri=d Airines I =] | ¥ Miimum Stay Required
|<N S J| ¥ Magimum Stay Required
ohe; -
¥ Advanced Purchase Required
= 3

Pieferred Service Class

Buzineszs = I

Flight Preferences dialog box (during flight selection)
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United Airlines is
preset as the first
preferred airline.

2. In the Preferred Airlines fields, select your second and third preferred
airlines. If the Use Preferences option is selected, United Connection
will display only flights operated by the preferred airlines.

3. In the Preferred Service Class field, select a service class. If the Use
Preferences option is selected, United Connection will display only
flights that have seats available in the preferred class.

Note: The Preferred Service Class option is ignored in FareShopper,
which returns the lowest available fares regardless of class.

4. In the Acceptable Fare Restrictions fields, select the fare restrictions
you are willing to accept when pricing a flight.

If the Use Preferences option is selected, United Connection will look
for fares based on the specified fare restrictions. If no available fare
meets all selected restrictions, United Connection will return a less
restrictive fare (it will never return a more restrictive fare).

5. If you want to save the updated preferences in the primary traveler's
profile, click Update Profile (this is optional).

6. To apply the updated preferences to the current flight only, click OK.
7. Click Yes if prompted to refresh the list of available flights.

Changing the list of available flights

If none of the flights listed in the Select Flight dialog box meet your needs,
you can update the flight list using one or more of the following options:

If available, click More Flights. United Connection displays additional
flights to your destination. (This option is not available in FareShopper.)

If the Use Preferences option is selected, you can broaden your search
by de-selecting this option. United Connection updates the flight list to
display all flights to your destination that have seating available.

Change your flight preferences for the flight. See “Changing Preferences
for the Current Flight” for more information.

If your schedule allows, consider planning your flight on a different date
when more flights might be available:

From the Select Flight dialog box, click Cancel to display the
Itinerary Window. Double-click on a flight to display the Edit Flight
dialog box, then change the specified departure date.

From the Select FareShopper(sm) Flights dialog box, click <<Fares
to return to the Select FareShopper(sm) Fares dialog box. Click
Supershop and specify date ranges to search within. See "Using
SuperShopper" above for more information.
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Changing the list of fares (in FareShopper)

If you don't see a fare you want in the Select FareShopper(sm) Fares dialog
box, you can update the list using one or more of the following options:

If the Use Preferences option is not selected, you can focus your
search by selecting this option. United Connection updates the list to
display available fares that conform to the primary traveler's flight
preferences.

If the Use Preferences option is selected, you can broaden your search
by de-selecting this option. United Connection updates the list of fares
to display the most restricted Coach fares on all available airlines.

Change your flight preferences for the flight. For more information, see
"Changing Preferences for the Current Flight."

If your schedule allows, use SuperShopper to search for low fares over a
full 24-hour period, or over a range of dates (up to two days before and
after your travel dates). This option is only available for itineraries of one
or two flights. See "Using SuperShopper" above for details.
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Select the traveler whose
service requests you want
to edit.

For connecting flights,
services apply to individual
flight segments. To apply a
change to all flight
segments, be sure to
select and modify the
services for each segment.

Some airlines do
not assign advance
seating. For more
information, please
contact the airline
directly.

Flight Services Requests

When you reserve your itinerary, United Connection forwards each
traveler's flight service requests to the appropriate airline(s). Flight services
include seating, meals, and special services. The flight service requests from
each traveler's profile are used as the default for that traveler. After selecting
a flight, you can review and edit flight services for all travelers.

In the Select Flight dialog box, the Flight Service Requests Summary dialog
box appears automatically after you select a flight. You can also display this
dialog box by clicking Requests in either the Edit Flight dialog box or the
Select FareShopper(sm) Flights dialog box.

To review or edit flight services:

1. Select the traveler whose services you want to review or edit. The
current service requests for that traveler are displayed in the table.

Flight Service Requests Summary

Flight Services For:

b1 5tephen Crawford

\ San Fran

Flight Segment
._I ol h N

San Francisco Intl Arpt [San Fran... Mo Special Mo
Los &ngeles Intl [Los &ngeles, &) at Airport Request  Reguest

| I |5t Taaetter ez Il Seat Map Edit...

¥ Shaw this summary after each flight zelection

Flight Service Requests Summary dialog box

2. If you selected a flight on United Airlines or United Express, you can
choose specific seats by clicking Seat Map. For more information, see
“Selecting Seats Using the Seat Map” later in this chapter.

On airlines other than United and United Express, “Sit Together” is the
only available seating option. When Sit Together is selected, United
Connection forwards the primary traveler's seating preference to the
airline and requests adjoining seats for all other travelers.

3. If you arranged any special services directly through the airline (for
example, allowance for excess or oversized baggage), click More Info.
to display those services.

4. To change a traveler's seating preference, meal request, or special
service request for a particular flight segment, highlight that segment and
click Edit. The Flight Service Requests dialog box appears.
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Flight Service Requests
Requests for

Traveler: Mr Stephen Crawford

From: i John F Kernedy Intl (New ok, HY] .
If you request a To: “# San Francizoo Intl &t [San Francizco, C8) |
wheelchair (for use at e ™
the airport), the traveler cestng [0 g Heart Smart
requiring the geating. | Aisle meals are
wheelchair must be Meal: | No Special Request j| El’ecteded \l;VItlh a
eart symbool.

able to ascepd and Special [<Nane> |
descend stairs. If - -
additional assistance is
needed, please contact o S e 07[

s . ther types of special services may be available. For maore /
the airline dlrectly. information, please contact the airline. l'!_fr,_«

Flight Service Requests dialog box

5. Make the necessary changes for this traveler as follows:

a. Inthe Seating field, select the traveler's preferred seating option for
this flight. If you have already selected a specific seat for this

Restrictions appl
PPy traveler, that seat number appears in the list.

to special meal

_re?ueStst', s b. In the Meal field, select the traveler's preferred meal request for this
riormation, see flight. All special meals must be requested at least 24 hours prior to
the online Help. departure

c. Inthe Special field, select from available special services.
6. Click OK. The Flight Service Requests Summary dialog box appears.
Repeat this process as necessary for each flight segment and traveler.

7. To exit the Flight Service Requests Summary dialog box, click OK.
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Selecting Seats Using the Seat Map

The Seat Map option lets you choose specific seats on United and United
Express flights using a seating layout of the aircraft scheduled for a
particular flight (for example, a 747 or DC-10). Available seats are shown
in white. Separate "maps" are provided for each service class.

Note: Mileage Plus” Premier travelers can select seats in the Premier seating
area (if available). If a Premier traveler is accompanied by a single non-
Premier companion, both travelers can select seats in the Premier area.

To select specific seats using the Seat Map:

1. Display the Select Seats dialog box by clicking Seat Map in one of the
following dialog boxes:

Select Flight dialog box
Flight Service Requests Summary dialog box
Select FareShopper(sm) Flights dialog box

Select Seats

Fram: |7 John F Kennedy Intl [Mew Yark, M) Depart: 0B/02/97 Time: 08:00a
i -

Ta t» Los Angeles Intl [Los Angeles, CA) Amrive:  0B/02/97 Time: 10:48a

Traveler

. Coach
Exit rows are marked o |

with an arrow. Exit row
seats may be subject to
restricted availability. OOD0O
Seats F @DDDDDD
184 Window Al 13 14 18 19 20 24 22 23 24 X%
T e : DOoDoO0DODDO
Middle —{® DOooDOOD0D0D
C13 14 15 16 17 9999999
To select a seat, click
on a seat shown in BABENANEB AN NED)
, AR EIRENINIRN)
white. An “X” appears
on that seat. To
deselect a seat, click on
the selected seat again. 208 < A i

Select Seats dialog box

2. In the From field, select the flight segment for which you want to
choose seats. A single flight segment appears for non-stop flights.

3. Inthe Traveler list, select the traveler whose seat you want to select.
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If you are using
FareShopper, in
most cases only the
Coach seat map
will be available.

4. Select a service class tab (First, Business, or Coach) to display the seat
map for that service class. You must select seats in the same service
class for all travelers in the itinerary.

5. Click on the seat you want to choose. Available seats are shown in
white. Unavailable seats are shown in gray. You can also select from
the list of seats.

To deselect a seat, click on it again, or select another seat from the list.

6. Repeat steps 2 through 5 to select seats for each traveler on each flight
segment.

7. When you are finished, click OK.

Note: If you change your seat assignment after receiving your ticket, your
boarding pass will be invalid. Please contact the gate agent at check-in for a
new boarding pass.




Chapter

Selecting Rental Cars

In this chapter, you will learn how to:

Enter rental car planning information
Select a rental car company

Edit preferences for rental cars
Select a rental car and rate

Specify rental car service requests

About adding rental cars to your itinerary

You add a rental car to your itinerary by entering planning information,
selecting a rental car company, choosing a car type and rate, and
specifying any additional services you require.

You can view a range of available rental car companies and car types, or
use car preferences to display only companies and car types that you
prefer. If the primary traveler belongs to rental car discount programs and
has entered this information in the Traveler Editor, you also have the
option of selecting a rental car that qualifies for one of these programs.

After you have selected a rental company and car type, you indicate any
special service requests that you would like to have forwarded to the rental
company — for example, a request for a car seat or a mobile phone.

When you reserve your itinerary, your rental car selection and service
requests are forwarded to the appropriate rental car company. A
confirmation number will appear in the Notices area of the Itinerary
Window once your reservation has been confirmed.

Note: Any changes to a rental car reservation must be made directly through
the rental car company — they cannot be made through United Connection.
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The destination of the last

flight without an

associated rental car is
displayed in the Airport

field by default.

Entering Rental Car Planning Information

Before you can select a rental car, you need to indicate where and when
you want to pick it up.

To plan a rental car:

1. In the Itinerary Window, choose the Add Car icon from the toolbar.
The Add Car dialog box appears.

Edit Car E

Plan Information

If you don't know

Pick-Up: [05/02/57 [E]  Time: [10:45 AM |§

Drop-0ff: [06/06/97 Ml Time: |07:00 A E

Car Selection

Ajrpart; |Los Angeles Intl (Lo Angeles, CAJ u E the airport name,
B click the down

arrow to search
by city, airport, or
airport code.

Cancel

Mo rental car has been selected. To find a rental
car, enter your planning information. Then choose

To view available

rental car
companies, click

the Find Cars button.

Find Cars.
Add Car dialog box
2. Complete the Add Car fields as follows:
In this field You can
Airport Enter or select the airport at which you will pick

up the rental car.

Pick-Up Date Enter or select a pick-up date.
Pick-Up Time Enter or select a pick-up time.
Drop-Off Date Enter or select a drop-off date.
Drop-Off Time Enter or select a drop-off time.

Note that all rental cars must be rented at airport locations, and all cars
must be returned to the location where they are picked up. In addition,
some rental companies require an airline ticket for rental. For more
information, choose Rate Details after selecting a car type or contact
the rental car company.
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The Location
column indicates
whether the rental
company service desk
is located inside the
airport terminal or at a
remote airport
location (which may
require shuttle
service).

Select the Use
Preferences option
to display companies
based on the primary
traveler's rental car
preferences.

3. To continue, do one of the following:

To view available car companies at the specified airport, click Find
Cars. The Select Rental Car Company dialog box appears.

To leave the car in Planned status for now, click OK. The Itinerary
Window displays the rental car planning information you entered.

Note: If you are not already connected to the reservation system when you
click Find Cars, you will be prompted to connect in order to display the
Select Rental Car Company dialog box.

Selecting a Rental Car Company

After you enter your rental car planning information, you are ready to select
a rental car company. The Select Rental Car Company dialog box displays a
list of available companies at the location you specified.

To select a rental car company:

1. Review the list of available rental car companies in the Select Rental
Car Company dialog box.

Select Rental Car Company [ %]

-oave ~arpor] . - .

Thity Tif-arport $91.56 - $131.56 o
Payless Off-airport $106.48 - $130.48 ezl
TEle TI520- §1400

Car Company Information [shows only agencies with cars available for the dates specified)

Rental Car Comnpaty Location Range of Total Rental
i t

Off-airport
ce Tif-arport 768 g6
Budget Ajrport terminal $131.96 - $291.96
Sears Airport terminal $131.95- $291.96
Az Ajrport terminal $175.80 - $255.80

Rental Car Plan
Airport: Loz Angeles Intl [Los_AngeIes, Ca

T
Pick-Up:  0B/02/97 Time: 10:46a ‘ Usze Preferences Edit ‘
Drop-0OFf:  DE/DBS97 Time: 07:00a Daps:4 Ly —I

Select Rental Car Company dialog box

Companies are listed by rate range for the specified rental period, from
lowest to highest. The planning information you entered and the total
number of days for this rental appear at the bottom of the dialog box.
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To use rental car
preferences when
adding a car to
your itinerary,
select the Use
Preferences
option.

2. To see the address, hours, additional charges, and other information for
a rental company, highlight that company and click Details. The Rental
Car Company Details dialog box appears. After viewing the details, click
Close to return to the Select Rental Car Company dialog box.

3. If you find a company you want to select, highlight it and continue
with step 4. If none of the rental car companies meet your needs, you
can change the list using one of the following options:

Click Edit and change car preferences. See "Editing Preferences for
the Current Rental Car" later in this chapter for more information.

If the Use Preferences option is selected, de-select this option.
United Connection then ignores the primary traveler's car
preferences and updates the list to display all rental companies at
the specified location that have cars available.

4. Highlight the rental car company you want to select and click OK. The
Select Rental Car Type dialog box appears.

Note about discounts: If the primary traveler entered rental car discount
program numbers in the Traveler Editor, the words "Discount program rate
applies" appears below the table and an asterisk is displayed next to those
company names. Choose one of those companies if you want to reserve a
rental car at the primary traveler's discount rate for that company.

Editing preferences for the current rental car

When you add a rental car to your itinerary, you can use the primary
traveler's rental car preferences to narrow your search by choosing the Use
Preferences option. If you use preferences, United Connection attempts to
find rental companies that meet all of the specified preferences. You can
edit these preferences during the rental car selection process.

To edit preferences for the current rental car:

1. In the Select Rental Car Company dialog box, select the Use
Preferences option (if it is not already selected).

2. Click Edit. The Car Preferences dialog box appears.
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If any of the
preferences cannot
be met, no rental
companies will
appear. To display
a list of available
rental companies
you will need to
change the affected
preferences.

To ignore the rate
range search
option, de-select
Search Within
Price Range.

Car Preferences

Uzing Primary Traveler's Preferences: Mr Stephen Crawford [Business Trips)

Car |

Frefs d Rental Comp

Acceptable Rate Range

|<N0ne>

Wpdate Erafile

j| ™ Search Within Price Range

|<N0ne>

j| Highest Bate: |0 Cancel

|<N0ne>

j| Lowest Rate: l:l

Fiates for L5 lozations only

Preferred Car Types

Opti

|<N0ne>

j| Only show rental car companies with:

|<N0ne>

j| ™ In Teminal Faciliiies

|<N0ne>

j| ™ Urlirvited Mileage

Car Preferences dialog box

3. Update the rental car preference fields as follows:

In this field

You can

Preferred Rental
Companies

Preferred Car
Types

Search Within
Price Range

In Terminal
Facilities

Unlimited Mileage

Select your three preferred rental car companies.

Select your three preferred car types. The default
option is None.

Select this option if you want United Connection
to display only rental car companies that offer
rates within a price range you specify. Then, do
the following:

a. In the Highest Rate field, enter the highest
daily rate you want to pay for a rental car.

b. In the Lowest Rate field, enter the lowest
daily rate you want to pay for a rental car.

Select this option if you prefer to rent a car from
companies that have service desks inside the
airport terminal, rather than at a remote airport
location (that may require shuttle service).

Select this option if you prefer to rent from
companies that offer an unlimited mileage plan.

If you want to save the updated preferences in the primary traveler's
profile, click Update Profile (this is optional).
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All detail
information is
provided directly
by the rental car
company. United
Airlines makes no
claim of its
accuracy.

5. To apply the new preferences to the current rental car only, click OK.

6. Click Yes if prompted to refresh the list of available rental car
companies. An updated list of companies appears.

Viewing rental car company details

You can view detailed information for any rental car company. This
includes address and hours, extra charges, and other information.

To view rental car company details:

1. In the Select Rental Car Company dialog box, highlight a company and
click Details. The Rental Car Company Details dialog box appears.

Rental Car Company Details - All American E

Description:
i | ALL AMERICAM AFFILIATE - FOX RENT A CAR

. Eutra Charges

. Mizcellaneous ALL AMERICAN

FOX REMT & CAR

10210 GLAS GOW PLACE

LOS ANGELES CA 30045
LOCATION 310-641-3838
RESERVATIONS 800-242-7743

Local: 800-225-4363  Reservations:

TAM-7PM DAILY

Rental Car Company Details dialog box

2. From the Type of Information list, select Address and Hours to view
the following information:

Rental company address
Hours of operation

Telephone number

If necessary, scroll down to view all the information.

3. From the Type of Information list, select Extra Charges to view the
following information:

Applicable state and local taxes
Refueling policies

Loss damage waiver information
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4.

5.

From the Type of Information list, select Miscellaneous to view the
following information:

Shuttle service schedule and instructions (if applicable)
Accepted credit cards

Driver's license requirements

Authorized drivers

Age requirement

Available car types/models

Click Close to return to the Select Rental Car Company dialog box.

Selecting a Rental Car Type

After you enter your rental car planning information and select a rental car
company, you are ready to select a car type.

Note: If the primary traveler entered a discount program number for the
selected company in the Traveler Editor, United Connection displays only
discount program options in the Select Rental Car Type dialog box. No rates
are displayed, since rates can vary between programs. To see standard rates,
turn off the Discount Program Rates option.

To select a rental car type:

1.

The planning information
you entered, the selected
rental car company, and
the total number of rental
days appear at the bottom
of the dialog box.

In the Select Rental Car Type dialog box, review the list of available
rental cars.

Select Rental Car Type
Car Type Inf tion
Car Tupe Rate Type Total Milzage
4-Door Economy wieekend $179.80 Unlirmited
Compact ‘wieekend $199.80 Unlirited
4-Door Compact wieekend $203.80 Unlirmited Eaed
Intermediate wieekend $223.80 Unlirnited
Standard wieekend $231.80 Unlimited Bate Detailz
Full Size wieekend $239.80 Unlirnited
Premium ‘wieekend $255.80 Unlirnited
Premium Special ‘wieekend $255.80 Unlirited

| I [Miscanmb EraaranmFates |

Rental Car Plan

Airport; Loz Angeles Intl [Log Angeles, CA) Company:  Aviz
Pick-Up:  0B/02/97 Time: 10:46a

Drop-0ff:  DBA0B/97 Tirme: 07:00a Days: 4

Select Rental Car Type dialog box

Cars are listed by rate, from lowest to highest.
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If you select a
discount program
option, the Rate
Details button will
not be available
(specific rate and
rules information is
not available for
each program).

If the Discount Program Rates option is selected and you wish to see
other available car types and rates, de-select this option.

Note: The Discount Program Rates option is only available if the
primary traveler entered a discount program number for the selected rental
car company in the Traveler Editor.

. To see additional information about the rate and mileage options for a

particular car type, highlight that car and click Rate Details. The
Rental Car Rate Details dialog box appears. Click Close to return to
the Select Rental Car Type dialog box.

Highlight the rental car you want to select and click OK. The Rental
Car Service Requests dialog box appears.

If this dialog box does not appear after you select a rental car type,
choose System Options from the Tools menu and select the Display
Rental Car Service Requests After Planning option.
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All rate information
is provided directly
by the rental car
company. United
Airlines makes no
claim of its
accuracy.

Viewing rental car rate details

Rental car rate information includes the rate calculation, mileage
information, and rules and conditions for the selected rental car.

To view rental car rate details:

1. In the Rental Car Rate Details dialog box, review the rate information for

the selected car.

Rental Car Rate Details [ %]

Rate Calculation

$48.95 / weekend -
Estra Day Amount: $43 95

Extra Day Mileage Allowance: Unlimited Milzage

Extra Hour &mount: $16.32 f

Extra Hour Mileage Allowance: Unlmited Milzage

Topbal B ee el 1 TE OO hd
«] | »

Unlimited Mileage

RAules and Conditions

FRIMIGHT O%¥ERSTAY

RETURN SAME CITY

Rental Car Rate Details dialog box

You may need to scroll down to see all of the information. Car rate
information can include:

Total rate, and a breakdown of the total by rate type

Mileage information, including the cents/mile cost (if applicable)

Late fees

Availability restrictions (i.e., must keep over a Saturday night)
Advance reservation requirements

Rate guarantees

Whether an airline ticket is required for rental

Maximum rental period

2. Click Close to return to the Select Rental Car Type dialog box.
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If the Rental Car
Service Requests
dialog box does
not appear after
you select a car
type, choose
System Options
from the Tools
menu and select
the Display Rental
Car Service
Requests After
Planning option.

Requesting Rental Car Services

After selecting a rental car, you can request rental car services. Rental car
services include infant and toddler car seats, controls for physically
challenged drivers, mobile phone, ski-equipped car, and associated
frequent flyer program. You specify these service requests in the Rental Car
Service Requests dialog box.

Important: United Connection cannot guarantee any rental car service requests
— please call the rental car company directly to confirm your requests. Once
you reserve a rental car, any changes to your reservation must be made directly
through the rental car company.

To display the Rental Car Service Requests dialog box:

The Rental Car Service Requests dialog box appears automatically after
you select a car type.

Once you have selected a rental car, double-click on the rental car in
the Itinerary Window to display the Edit Car dialog box, then click
Requests.

Rental Car Service Requests

Additional Service Requests

[~ Toddler Car Seat

™ Car Equipped for Physically Challenged Driver
£ L=t Hard Cortals
£ Bkt Hand Bt

[~ Mabile telephone
™ Ski-equipped car [zki rack, snow ties, etc.)

Azzociated Ereguent Elyer; Brogram:

| o

¥ Show these options after choosing a rental car

Rental Car Service Requests dialog box
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To request rental car services:

1. Select the desired rental car service requests. The default services are
those specified in the primary traveler's profile.

This field contains
a list of frequent
flyer programs
entered for the
primary traveler in

the Traveler Editor.

For more
information, see
Chapter 4, Profiles
and Preferences.

In this field

You can

Infant Car Seat
Toddler Car Seat
Car Equipped for

Physically
Challenged Driver

Mobile Phone

Ski-Equipped Car

Associated
Frequent Flyer
Program

Select an infant car seat.
Select a toddler car seat.

Select a car equipped for a physically challenged
driver. Then, select one of the following:

Left Hand Controls
Right Hand Controls
Select a car equipped with a mobile phone.

Select a car with a ski rack, snow tires, etc.

Select one of the primary traveler's frequent flyer
programs to send that program number to the
rental company. If the selected program has a
promotional agreement with the rental company,
the primary traveler may be eligible for any
benefits offered under that promotion.

Other restrictions may apply — please contact
the rental car company or your frequent flyer
program for details. You may be required to
show proof of program membership (for
example, your frequent flyer card) at pick-up.

2. After selecting rental car services, click OK to return to the Itinerary
Window which is updated to display the rental car you selected.
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Updated Itinerary Window

» 1itn - United Connection
File Edt “iew ltinerary Tools

Help

e | L
AOD HOTEL FIND oP

ARSI Mon 06/02/97 10:46a

John F Kennedy Intl [Mew Yok, N

Seat: Requested

Y st i’
0 PRINT

Travelers Totals Motices

tr Stephen Crawford Flight Cost: $2101.00UsD
Car Estimate: $22380 050
Hotel Estimate: 1]
P Flight Miles: 4350

Status | Date/Time Location ‘ Details l;

1 United 0075 Clazs: Business
ton 08/02/97 08:00a

Loz Angeles Intl [Loz Angeles, CA)

United 0020 Clazs: Business
Fri  0B/06/37 07:00a Los &ngeles Intl [Los Angeles, CA) Seat. Beguested
=EREm N Fri  06/06/97 03:14p John F Fennedy Int [Hew York, NY)
Ready

[Wed U3/04/%6 1019
Itinerary Window updated to show the selected rental car

| == Cornected g

When you are ready to reserve the selected flights, rental cars, and hotel
rooms in your itinerary, choose the Reserve icon from the toolbar. See
Chapter 9, Reserving Your ltinerary, for more information.



Selecting Hotel Accommodations

Chapter

In this chapter, you will learn how to:

Enter hotel planning information
Select a hotel

Edit hotel preferences

Select a hotel room and rate

Specify hotel service requests

About adding hotel rooms to your itinerary

You add a hotel room to your itinerary by entering planning information,
selecting a hotel, choosing a room type and rate, and specifying any
additional services you require.

You can view a range of available hotels and room types, or use hotel
preferences to display only hotels and room types that you prefer. If the
primary traveler belongs to hotel discount programs and has entered this
information in the Traveler Editor, you also have the option of selecting a
hotel that qualifies for one of these programs.

Once you have selected a hotel and room type, you indicate any special
service requests that you would like to have forwarded to the hotel — for
example, a request for a late arrival guarantee or additional beds.

When you reserve your itinerary, your room selection and service requests
are forwarded to the appropriate hotel. A confirmation number will appear
in the Notices area of the Itinerary Window once your reservation has been
confirmed.

Note: Any changes to a hotel reservation must be made directly through the
hotel, not through United Connection.
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The destination of the
last flight without an
associated hotel is
displayed in the
Location field by
default.

Entering Hotel Planning Information

Before you can select a hotel, you need to specify a location, distance from
reference point, and check-in and check-out dates.

To plan a hotel stay:

1. In the Itinerary Window, choose the Add Hotel icon from the toolbar.
The Add Hotel dialog box appears.

Add Hotel

Plan Information

If you don't know the
airport name, click on

Lacatioh; |Los Angeles Intl [Loz Angeles, CA)

the down arrow next

Wwiithi: |20 E Miles af: |Los Angeles [ntl

Check-In:

to the Location field

to search by city,
airport, or airport

Hotel Selection

Mo hotel has been selected. Tofind a hatel. enter
wour planning information.  Then choose the Find

Hatels button.

code.

To view available
hotel properties, click
Find Hotels.

Add Hotel dialog box

2. Complete the Add Hotel fields as follows:

In this field You can

Location Enter or select the airport or city where you wish
to stay.

Within Indicate (in number of miles) the greatest
distance you are willing to stay from your
reference point. The default is 20 miles.

Miles Of Select the reference point you want to stay near.
The default is the airport at the selected location.
References points vary by location.

Check-In Enter or select a check-in date.

Check-Out Enter or select a check-out date.
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3. To continue, do one of the following:

To view a list of available hotels at or near the specified location,
click Find Hotels. The Select Hotel dialog box appears.

To leave the hotel in Planned status for now, click OK. The Itinerary
Window displays the hotel planning information you entered.

Note: If you are not already connected to the reservation system when you
choose the Find Hotels button, you will be prompted to connect in order to
display the Select Hotel dialog box.

Selecting a Hotel

After you enter your hotel planning information, you are ready to select a
hotel. The Select Hotel dialog box displays a list of available hotels at the
location you specified.

To select a hotel:

1. In the Select Hotel dialog box, review the list of available hotels.

Select Hotel E

Hotel Information [zhows only hatels with rooms available for the dates specified] ; :
Corfart Innz Comfart Towne 41225 Western Ave. Imies NE  $ 47 - §$ 56/day oK

Best western South Bap Hotel Lawndale Ca 8 miles SE $48- % 70/day

Howard Johnzon  Howard Johnzon tontebello Ca 17 milez E $ 49 - § 59/day Caticel
Best western Dragon Gate Inn 818 N. Hill 5t 15 milezs ME  $52 - $53/day -
“Yagabond Inng Yagabond Glendale 120" Colorado St 19milezs ME  $55- $ 64/day
Travelodge Travelodge El Segundo Ca 1 miles 5 $57-$61/day

Best Westemn Ghwy Santa Monica Santa Monica Ca Smiles MW $ 59 - $120/day
Flamada Hotelz FRamada Hotels 3900 wilzhire Blvd 12 milez ME ~ $ B9 - $ 89/day

Courtyard Courtpard Taomance Ca 7 milez 5 382 - $ 96/day

Radizzon Loz Angeles Harbor San Pedro Ca 19milez SE  $99- $129/day

Holiday Inng Loz Angeles Dwhtwn 750 Garland Avenue 13 miles NE - $119/day

Hotel Plan

Located:  ‘Within 20 miles of Loz Angeles Intl [Los Angeles,

Check-n:  06/02/97 ™ Lse Preferences Edit ‘

Check-Out:  06/06/97 Nights: 4

Select Hotel dialog box

Hotels are listed by rate, from lowest to highest. The planning
information you entered and the total number of nights for this stay
appear at the bottom of the dialog box.
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2. To see the address, phone number(s), policies, location, services, and
other information for a particular hotel, highlight that hotel and click
Details. The Hotel Details dialog box appears. After viewing the details,
click Close to return to the Select Hotel dialog box.

3. If you find a hotel that you want to select, highlight it and continue
with step 4. If none of the hotels meets your needs, you can change the

If you want to use list using one of the following options:

hotel preferences

when adding a - If available, click More Hotels. United Connection displays
hotel room to your additional hotels at the specified location.
itinerary, you must

Click Edit and change hotel preferences. See "Editing Preferences

lect Use S . .
celee for the Current Hotel" later in this chapter for more information.

Preferences.
If the Use Preferences option is selected, de-select this option.

United Connection ignores the primary traveler's hotel preferences
and updates the list to display a range of hotels at the specified
location that have rooms available.

4. Highlight the hotel you want to select and click OK. The Select Room
Type dialog box appears.

Note about discounts: If the primary traveler entered hotel discount
program numbers in the Traveler Editor, the words "Discount program rate
applies" appears below the table and an asterisk is displayed next to those
hotel names. Choose one of those hotels if you want to reserve a hotel
room at the primary traveler's discount rate for that hotel.

Editing preferences for the current hotel room

When you add a hotel room to your itinerary, you can use the primary
traveler's hotel preferences to narrow your search by choosing the Use
Preferences option. If you use preferences, United Connection attempts to
find hotels that meet all of the specified preferences. You can edit these
preferences during the hotel room selection process.

To edit preferences for the current hotel room:

1. In the Select Hotel dialog box, select the Use Preferences option (if it
is not already selected).

2. Click Edit. The Hotel Preferences dialog box appears.
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Hotel Preferences
Uzing Primary Traveler's Preferences: Mr Stephen Crawford [Business Trips)

If one or more

preferences cannot Hotel |
be met/ United FPreferred Hotel Chains Freferred Rate Category -
Connection [Nore> ] [Comorate =] Update Profil

displays available
hotels that meet

Cancel

|<N0ne> j| A ble Rate Range
s <Mone: = e
other specified | = :
reterences. - -
p Preferred Occupancy: Double J Lowsst Rate: l:l

Preferred Amenities Rates for 1.5, locations only

F::;;Z::::Enmg = Which iz most important to you?
[ Barber & Hotel Chain

[ Beauty Shap " Room Rates

I Cable T ~ " Amgnities

Hotel Preferences dialog box

3. Complete the hotel preference fields as follows:

In this field You can
Preferred Hotel Select your three preferred hotel chains. The
Chains default option is None.
Preferred Select Single or Double occupancy.
Occupancy
Preferred Select up to eight amenities.
Amenities
Preferred Rate Select one of the following: Standard, Corporate,
Category Senior Citizen, Club Level, or Weekend.
) Search Within Select this option to have United Connection
To ignore the rate Price Range display only hotels that offer room rates within a
8 play only

range search

option, de-select . ) .
Search Within a. In the Highest Rate field, enter the highest

Price Range. rate (per night) you want to pay for a room.

price range you specify. Then, do the following:

b. In the Lowest Rate field, enter the lowest rate
(per night) you want to pay for a room.

Which Is Most Select the hotel preference that is most important

Important To You to you: Hotel Chain, Room Rates, or Amenities.
United Connection will try to find hotels that
meet all your preferences. However, a higher
priority is placed on finding hotels that meet the
Most Important preference.
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All detail
information is
provided directly
by the hotel.
United Airlines
makes no claim of
its accuracy.

4. If you want to save the new preferences in the primary traveler's profile,
click Update Profile (this is optional).

5. To apply the new preferences to the current hotel only, click OK.

6. Click Yes if prompted to refresh the list of available hotels. An updated
list of hotels appears.

Viewing hotel details

You can view detailed information for any hotel. This includes the address,
phone number(s), policies, location, services, and other information.

To view hotel details:

1. In the Select Hotel dialog box, highlight a hotel and click Details. The
Hotel Details dialog box appears.

Hotel Details E3

Description:
i | Mame: Fadisson Los Angeles Harbaor

@_ Paolicies

[~ ® Cancellation Policies
— ® Credit Cards Accepted
— * Deposit Requirements
— ®* Guarantes Policy

— ® Tauation AA4 Rating:  N/A

Address: 601 5 Palos Verdes Steet
San Pedo Ca 90731

P8 Location

— *® Directions

— *® Location

— ® Transportation
B Services

— *® Facilities

— ® Services

— ® Other

Phore: 310519-8200 Check-ln Time: 3P
Fau: 310 519-8421 Check-Out Time: 12N

Hotel Details dialog box

2. From the Type of Information list, select General Information to view
the following information:

Full property name

Address

Phone number

Fax number

Check-in and check-out times
AAA rating (if available)

Descriptive text

If necessary, scroll down to view all of the information.
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3. In the Type of Information list, double-click on one of the remaining
topics to display a list of available options for that topic. These are:

Policies:
Cancellation policies
Credit cards accepted
Deposit requirements
Guarantee policy
Taxation

Location:
Directions
Location
Transportation

Services:
Facilities
Services
Other

Highlight a topic to display the corresponding information. If necessary,
scroll down to view all of the information.

4. Click Close to return to the Select Hotel dialog box.
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Selecting a Room Type

After you enter your hotel planning information and select a hotel, you are
ready to select a room type.

Note: If the primary traveler entered a discount program number for the
selected hotel in the Traveler Editor, United Connection displays only discount
program options in the Select Rental Room Type dialog box. No rates are
displayed, since rates can vary between programs. To see standard rates, turn
off the Discount Program Rates option.

To select a room type:

1. In the Select Room Type dialog box, review the list of available hotel
rooms. Hotels are listed by room rate, from lowest to highest.
Room Type Information
Standard Deluse Room 1 King bed $129.00/day $516.00/stay
Standard Delure Room 2 Double beds $129.00/day $516.00/stay
Standard Deluse Room 2 Double beds $129.00/day $516.00/stay
Standard Superior Room 1 King bed $119.00/day $476.00/stay
Standard Superior Room 1 King bed $119.00/day $476.00/stay
Standard Superior Room 2 Double beds $119.00/day $476.00/stay
Standard Superior Room 2 Double beds $113.00/day $476.00/stay 'l
4 3
The check-in and check- I;ﬁLeCE[ierzlngeL:Eran:e required far | e T |
out dates, hotel name, R
address’ and phone Hotel Plan Fiadizzon Loz Angeles Harbor
number appear at the — B0 § Palos Verdes Steet
R Check Im 0B/D2/97 San Pedro Ca 90731
bottom of the dialog box. Check Out  DG/06/97 310519:8200
Select Room Type dialog box

2. If the Discount Program Rates option is selected and you want to
see other available room types and rates, de-select this option.

3. If a guarantee or deposit is required, a message will appear below the
list of hotel rooms. If you select one of these rooms, you will be required
to provide a credit card to guarantee the room when you reserve your
itinerary. Refer to online Help for more information about hotel room
guarantee requirements.

4. Highlight the room type you want to select and click OK. The Hotel

Service Requests dialog box appears.



Chapter 8: Selecting Hotel Accommodations 111

If the Hotel Service

Requests dialog
box does not
appear after you
select a room type,
choose System
Options from the
Tools menu and
select the Display
Hotel Service
Requests After
Planning option.

Requesting Hotel Services

After selecting a hotel, you can request hotel services. Hotel services
include guarantee for late arrival, additional guests in room, additional beds
and/or cribs in room, and associated frequent flyer program.

Important: United Connection cannot guarantee any hotel service requests —
please call the hotel directly to confirm your requests. Once you reserve a
hotel room, any changes must be made directly through the hotel.

To display the Hotel Service Requests dialog box:

The Hotel Service Requests dialog box appears automatically after you
select a room type.

Once you have selected a hotel room, double-click on the hotel room
in the Itinerary Window to display the Edit Hotel dialog box, and then
click Requests.

Hotel Service Requests

Guest Reservation Requests

[~ Guarantes room for ate arrivak

Mumber of:

Additional Adults in Room: OlE

Addtional Childrenin Room: [0 |2

Hel
Rall-dway Bed: Required: m‘ﬂ_‘ =k
Cribz R equired: ms‘
Azzociated Erequent Elyer BErogram:

¥ Shaow these options after planning a hatel stay

Hotel Service Requests dialog box
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The Additional
Adults/Children
In Room options
apply to double-
occupancy rooms
only. Do not
include the first
two occupants.

This field contains
a list of frequent
flyer programs
entered for the
primary traveler in

the Traveler Editor.

For more
information, see
Chapter 4, Profiles
and Preferences.

To request hotel services:

1.

2.

Select the desired hotel service requests. The default services are those
specified in the primary traveler's profile.

In this field

You can

Guarantee Room
For Late Arrival

Additional Adults
In Room

Additional
Children In Room

Roll-Away Beds
Required

Cribs Required

Associated
Frequent Flyer
Program

Select this option to hold the room regardless of
your arrival time. You will need to provide a
credit card to hold your reservation.

Specify the number of additional adults that will
be sharing the room.

Specify the number of additional children that
will be sharing the room.

Specify the number of additional beds required.

Specify the number of cribs required.

Select one of the primary traveler's frequent flyer
programs to send that program number to the
hotel. If the selected frequent flyer program has a
promotional agreement with the hotel, the
primary traveler may be eligible for any benefits
offered under that promotion.

Other restrictions may apply — please contact
the hotel or your frequent flyer program for
details. You may be required to show proof of
program membership (for example, your frequent
flyer card) at check-in.

Click OK to return to the Itinerary Window, which is updated to
display the hotel room you selected.
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Updated Itinerary Window

1itn - United Connection

e Edit “iew [ltnerary Tool: Help

GHOP

Travelers Totals Motices

tr Stephen Crawford Flight Cost: $2101.00UsD
Car Estimate: $22380 050
Hotel Estimate:  $556.00 USD
P Flight Miles: 4350

Status | Date/Time Location ‘ Details l;

1 United 0075 Clazs: Business
ton 08/02/97 08:00a

John F Kennedy Intl [Mew Yok, N

Seat: Requested
Loz Angeles Intl [Loz Angeles, CA)

a8 SN Mon DB/02/97 10:46a
Auvis

Mon 0B/02/97 10:48a
siEREE)ae Fi  0B/05/97 07:00a

Type: Intermediate

Las Angeles Intl [Los Angeles, CA) Rate Type: weekend  Totak $223.80U5D

irport

W United 0020

Clazs: Business
Fri  0B/06/37 07:00a Los &ngeles Intl [Los Angeles, CA) Seat: Requested —
SELECTED W =Tl =h ey b ) John F Kennedy Intl [Mew vYork, N'v)

eady & :21p oninecte
Read Wwed 03/04/36 10:21 =D=C d

Itinerary Window updated to show the selected hotel room

When you are ready to reserve the selected flights, rental cars, and hotel
accommodations in your itinerary, choose the Reserve icon from the
toolbar. See Chapter 9, Reserving Your ltinerary, for more information.



Chapter

Reserving Your Itinerary

In this chapter, you will learn how to:
Review your itinerary
Select a ticketing option
Choose a credit card
Finalize your reservation

Review electronic ticket information

About reserving your itinerary

After you have finished selecting flights, rental cars, and hotel
accommodations, you are ready to reserve your itinerary and send the
information to the reservation system. Before finalizing your reservation,
you are given the opportunity to review the flights, rental cars, and hotel
rooms you have selected, as well as the associated costs and rules.

Next, you indicate how you want to receive your ticket. You can choose
Electronic Ticket (if available), or arrange to have your ticket delivered. If
you do not want to pay online you can pick up your ticket at a United
ticket office or your preferred Apollo travel agency. Note that a credit card
is required even if you are not paying for your ticket online — United
Connection uses the credit card billing address as a contact address.

Finally, you enter a descriptive name for your itinerary and send the
information to United Airlines' reservation system.

Note: If you make changes to your itinerary after reserving, you must re-
reserve the itinerary to send the new information to the reservation system.
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Reviewing Your Itinerary

You access the Pricing Summary dialog box to review your itinerary before
sending it to the reservation system.

To review your itinerary:

1. In the Itinerary Window, make sure that you have selected all the flights,
cars, and hotels you want to include in your itinerary. You cannot
reserve an itinerary that includes Planned items.

2. Choose the Reserve icon from the toolbar. The Pricing Summary dialog
box appears.

Pricing Summary

FalesJ'Hulesl Flight | Car | Hotel |

Travelers:
b1 Stephen Crawford [ Adult $2101.00]

Fare Total:
$ 2101.00
Thiz itinerary must be ticketed by September 07, 1336 for this fare to be valid
Changes to a ticketed itinerary may result in a fare difference and/or a service charge.
that will require you to exchange the ticket at a United Ailines aiport ticket office
or city ticket office.
The fare quated for this itinerary is not guarantesd until the ticket is purchased

Pricing Summary dialog box

3. This dialog box can include up to four tabs:

Select this tab To display the following information

Fares/Rules Traveler names and types, airfare by traveler,
total airfare, fare rules.

Flight Summary of the selected flights. If you wish, you
can change the Acceptable Fare Restrictions to
see if a lower fare is available.

Car Summary of the selected rental cars and an
estimated rental car total (if available).

Hotel Summary of the selected hotels and an estimated
hotel total (if available).

4. If you are satisfied with the itinerary, click Reserve to continue. The
Ticketing Options dialog box appears.
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If you do not pay
for your ticket
immediately, your
airfare is not
guaranteed and
your reservation
will be canceled if
the ticket is not
purchased by a
specified ticketing
deadline.

Important: If you
purchase electronic
tickets, each traveler
will be required to
show photo ID at
check-in. Also, the
credit card used to
purchase the
electronic ticket
MUST be presented
by the cardholder at
check-in.

Selecting a Ticketing Option

If your itinerary includes flights, you need to indicate how you want to
receive your airline ticket. United Connection provides up to five ticketing
options, depending on your itinerary and the information you provided.
Three of the ticketing options require that you pay for your ticket online
with a credit card. The other two do not require immediate payment.

To select a ticketing option for your itinerary:

1.

Review the options displayed in the Ticketing Options dialog box.

Ticketing Options
i
Flrst Claszs Mail Delivery

United Ticketing Locations

Express Delivery [2 to 3 Busineszs Daps)

< Previous
Cancel

Dregcription:

If you select this option, pour aifare will be
guarantesd and your Electronic Ticket will be
stored in United Aillines' reservation system,

Ticketing Options dialog box

2. Highlight a ticketing option to see a description of that option. One or
more of the following ticketing options will be available:

Ticketing option

Description

Electronic Ticket

Online Payment Required. Electronic Ticket
eliminates paper tickets by storing your ticket
electronically. Your airfare is guaranteed.

Electronic Ticket rules:

All flights must be on United or United
Express

All flights must be within the U.S. and/or
San Juan

The itinerary can include up to 4 segments

Other restrictions may also apply in certain
markets.
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You specify your
preferred Apollo
travel agency in the
System Options
dialog box.

Ticketing option

Description

First Class
Mail Delivery

Express Delivery (2
to 3 Business Days)

United Ticketing
Locations

Apollo travel agency

Online Payment Required. Your ticket will be
delivered via first class mail within seven days.
Your airfare is guaranteed.

Online Payment Required. Your ticket will
arrive by express delivery (for example,
Federal Express), normally within two to three
business days. Your airfare is guaranteed.

No Online Payment. You need to go to a United
Airlines ticket office to purchase your ticket. Your
airfare is not guaranteed, and your reservation
will be canceled unless you purchase your ticket
before the ticketing deadline.

No Online Payment. You need to purchase
your ticket through your preferred Apollo
travel agency. Note that your airfare is not
guaranteed, and your reservation will be
canceled unless you purchase your ticket
before the ticketing deadline.

Refer to online Help for a full description of each ticketing option.

. To see information about United ticketing offices in your area, click

Offices. See “Finding United Ticketing Locations” later in this chapter.

. Select the desired ticketing option and click Next>. The Payment

Method and Delivery Address dialog box appears.
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Finding United Ticketing Locations

If you choose the United Ticketing Locations ticketing option, you will need
to go a United Airlines city ticket office or airport ticket office to purchase
your ticket. United Connection makes it easy to get information about
nearby locations simply by entering your zip code.

To find a United ticketing location:

1. In the Ticketing Options dialog box, click Offices. The United Ticketing
Offices dialog box appears.

2. In the Zip Code field, type the zip code in which you want to find
ticketing offices.

3. Click Find. United Connection displays the names and addresses of all
available ticketing offices located in the zip code you entered.

4. To see details for a particular ticketing office (for example, office hours),
highlight that office. Additional information about the ticketing office
appears in the Details area.

5. Click Close to return to the Ticketing Options dialog box.

Selecting a Credit Card

You must select a credit card each time you reserve an itinerary (even if you
are not paying for your ticket online). If you chose a ticketing option that
requires immediate payment, your airfare will be charged to the selected
credit card, and tickets sent by First Class Mail or Express Delivery will be
delivered to the billing address associated with that card. If you are not
paying for your ticket online, United Connection uses the billing address of
the selected credit card as a contact address.

You select a credit card in the Payment Method And Delivery Address
dialog box, which appears automatically after you select a ticketing option.
To select a credit card:

1. In the Payment Method and Delivery Address dialog box, select the
person who will be paying for the ticket. The credit cards entered for
that person in the Traveler Editor are displayed.
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The person you
select does not
have to be
included in the
itinerary.

Payment Method and Delivery Address

Flight | Guarantee Hotel |

Flease select a credit card to pay for your airfare.

Chooze a credit card from this traveler: Mr Stephen Crawfard j|

Lredit Card Biling/Delivery Address

Payment Method and Delivery Address dialog box

If you are not paying for your ticket now, select the individual you want
to designate as the contact person.

2. Highlight the credit card you want to select:

If you chose a ticketing option that requires you to pay for your
ticket online, your airfare will be charged to this credit card. These
options are Electronic Ticket, First Class Mail, and Express Delivery.

If you chose a ticketing option that does not require you to pay for
your ticket online, this credit card will not be charged. These options
are United Ticketing Locations and Apollo Travel Agency.

Note: If you select First Class Mail or Express Delivery, your ticket will be
sent to the billing address of the selected credit card.

3. If your itinerary includes hotel reservations for which a deposit or
guarantee is required, select the Guarantee Hotel tab and choose a
credit card to guarantee your hotel accommodations.

4. To continue, click Next>. The Confirm Reservation dialog box appears.

Credit card validation for electronic tickets

Before issuing an electronic ticket request, United Connection validates
your credit card information. If a problem is detected (for example, an
invalid address), United Connection gives you the option of changing your
credit card information or choosing a different credit card. See the online
Help for more information about credit card validation problems.
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The name you enter here
will be referenced with the
confirmation number.

Confirming Your Reservation

After selecting a ticketing option and providing a credit card, you're ready
to finalize your reservation and forward it to the reservation system. You
complete the reservation process in the Confirm Reservation dialog box,
which appears automatically after you choose a credit card in the Payment
Method and Delivery Address dialog box and click Next>.

To confirm your reservation:

1. In the Confirm Reservation dialog box, type a name for your itinerary.
You may use up to 15 characters. Spaces are permitted.

Confirm Reservation

Fleaze enter a descriptive name for thiz itinerany: L& Trid

Pleaze read and confim the following information:

"our flight selections will be reserved and the aifare will be guaranteed. ﬂ
Ticketing Option Selected: First Class Mail Delivery
[ IF you zelect thiz option, pour sifare will be guaranteed and pour tick et will be & [l
deliversd by first class mail within seven days. First class mail delivery iz
avallable for U.5. addresses anly. |

Cancel

The tatal cost of the flight portion of the itinerary i= $2101.00(050). Help
Thiz amount will be charged to Mr Stephen Crawford's American Express.
The tickets for this tinerary will be delivered to the fallowing address:

123 Main St.

Mew ork, NY100000007

Changes to a ticketed itinerary may result in a fare difference and/or a service
charge.

1'our hotel rezervation(z] will be requested.

Confirm Reservation dialog box

2. Carefully review the reservation summary information. You may need

to scroll down to review the entire summary.

3. To finalize your reservation, click Finish. United Connection

immediately sends your itinerary to the reservation system.

Note: Airlines do not release their inventory until you confirm your
reservation. Therefore, it is possible that the flights and/or fare that you
selected will no longer be available. If this occurs, United Connection
displays a message informing you of your options.

4. When the reservation system finishes processing your itinerary, a

confirmation dialog box appears. You are also informed if the
reservation system was unable to confirm any part of your itinerary.

5. To return to the Itinerary Window, click Done.
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Electronic ticketing

When you choose Electronic Ticket as your ticketing option and complete
your reservation, United Connection sends your electronic ticket request to
the reservation system. If the request is successful, United Connection
displays a dialog containing your electronic ticket receipt information. This
information includes:

The reservation number and name

The name of each traveler and their ticket number

The price of each ticket (including detailed fare basis information)
The Mileage Plus number of each traveler (if available)

The date the ticket was issued

The credit card used to purchase the ticket(s)

Passenger notices

You can view or print your electronic ticket receipt information at any time
by selecting Electronic Ticket Information from the View menu.

Electronic Ticket Information

Pleaze print a copy of this receipt for your records.

RECEIPT - RESERVATION NUMEER: 40MODX RESERVATION NAME: prodict
[PARTY OF (1) TICKETNOQ. EBASE TAX Tax  TOTAL

CRAWFORD/STEPHEN 0162101692707 T49.09 03D 749103 3.00XF SE7.0003D
TICKETISZUED: 04 SEF 96

FERPASIENGER - DI601100474003107 1 004300 Pritit Beceipt

FARE DETALLZTARE BASISEUA  FCGDECIFE UALAX 749.09 USDP49.09 END XETEKS -
Frint Motices

5
Flease read the following United Ailines Passenger Motices before traveling:
A CARRIERRPASSEMNGER MOTICES

Incorporated Terms
Airtransportation to be provided by United Airlines, Shuttle by United or a United
Express carrier (collectively, "UA Carrier"y hetweaen points inthe LS. or !
international transportation is subject to terms which are herein incorporated by ;I

Electronic Ticket Information dialog box

Important: If you purchase electronic tickets, each traveler will be required
to show photo ID at check-in. Also, the credit card used to purchase the
electronic ticket MUST be presented by the cardholder at check-in.
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Saving your receipt information

Electronic ticket receipt information is saved along with your itinerary when
you choose Save or Save As from the file menu. We recommend that you
save your itinerary before exiting United Connection.

Retrieving updated receipt information

When you select Electronic Ticket Information from the View menu,
United Connection automatically retrieves the current receipt information
from the reservation system and displays this information in the dialog box.
The reservation system stores your electronic ticket receipt information until
three days after travel is complete. After that, United Connection will
display the electronic ticket receipt information from your saved itinerary.

Ticket exchanges and refunds

United Airlines’ standard cancellation, refund, and exchange policies apply
to electronic tickets purchased through United Connection. Changes to a
ticketed itinerary that results in a fare difference and/or a service charge will
require you to contact United Airlines Reservations or a United Airlines city
or airport ticket office to exchange the ticket.
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Updated Itinerary Window

1.itn - United Connection

Edit “iew ltinerary Tools Help

L _HINDO

ITINERARY
Travelers Totals Motices
tr Stephen Cramford Flight Cast: $2101.00USD Itinerary Mame: L&, Trip
Car Estimate: a Itinerary Confirmnation Mumber. £203P1
Haotel Estimate: $636.00 USD Thiz itinerary has been reserved.
P Flight Miles: 4950 ‘Y'ou must purchase your ticket by Sep 07,

h Wiyndham Hotelz Wiyndhan Lax Airpor Type: DIk King
Mon 06/02/97 Formerly The Lax Airport Hy Fiate: $159.00/night USD
A= Fri O6/06/97 310 670-3000 Confimnation #: FZ6E0665
* United 0020 Clazs: Business
Fri  0B/08/97 07:00a Loz Angeles Intl [Los Angeles, CA) Seat. BB
A8 Fri 0B/06/37 0314p John F Kennedy [nH [Mew York, NY)
Ready |Wed 039/04/96 10:28p | ={13= Connected s

Updated Itinerary Window showing a completed itinerary

You will see the following information in the Itinerary window:

The Notices area displays the itinerary name and confirmation
number. If you have not paid for your ticket, the ticketing deadline is
also displayed.

The Totals area displays the total airfare, estimated total hotel cost,
and Mileage Plus miles. Estimated rental car cost is not displayed
(this information is not returned by the reservation system).

If you paid for your ticket online, the status of all flights is Ticketed.
If you did not pay for your ticket, the status of all flights is Reserved.
The status of all rental car and hotel items is Reserved.

Save your itinerary by choosing Save from the File menu. If you have not
saved your itinerary before now, you will need to enter a file name.

To print a trip report of your itinerary, choose Print from the File menu.
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®

Flight Status and Mileage Plus

In this chapter, you will learn how to:
Check the status of a flight
Review your Mileage Plus account summary

Compute Mileage Plus miles between cities

About Flight Status and Mileage Plus options

Flight Status. Need to check flight arrival or departure times? Don't pick up
the phone... let United Connection do it for you! Just enter the airline,
flight number, and departure date. Additional information is available for
United and United Express flights, including gates, actual and estimated
departure/arrival times, and explanation of any delays or cancellations.

Mileage Plus Summary. For up-to-date information about your Mileage
Plus account, look no further than United Connection. You can review
your member level, program balances, and information about recent
credited flights. Information is available for anyone in the Traveler Editor
whose traveler information includes a Mileage Plus number.

Mileage Plus Miles Between Cities. Want to know the Mileage Plus miles
between two cities? Just enter your origin and destination airports... if
mileage is available, you’ll have it in seconds. A running balance keeps
track of the total mileage as you calculate additional city pairs.

Note: You will need to connect to the reservation system when prompted in
order to use the Flight Status or Mileage Plus options.




126 United Connection User Manual

Checking Flight Status

United Connection lets you check the status of any flight in the reservation
system — all you need to provide is the airline, flight number, and
departure date. United Connection can display actual operational data for
all United and United Express flights leaving today, tomorrow, or yesterday.
This includes gate information and whether the flight is early or delayed.
Schedule information is displayed for all other flights.

To check flight status:

1. From the Tools menu, choose Flight Status. The Check Flight Status
dialog box appears.

Check Flight Status

Flight Information |
Luirline:; |United Airlines Inc jl H 5

s

Optional

Framm: |J0hn F Kennedy Intl [Mew ork, NY) |j

Check Flight Status dialog box

2. Complete the Check Flight Status fields as follows:

In this field You can

Airline Enter or select the name of the airline whose
flight you want to check.

Flight # Enter the flight number whose status you want
to check.

Date Enter or select the departure date.

From Enter or select the origin airport. This information
is optional.

3. Click OK. The Flight Status dialog box appears.
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4. Review the flight status information. The flight number, airline, and
departure date are displayed at the top of the dialog box. The table
displays information for each segment of the selected flight.

Operational information is displayed for all United and United Express
flights departing on the current day, the following day, or the previous
day. This includes:

Departure and arrival airports
Departure and arrival gates
Actual (or estimated) departure time

Whether the departure is delayed or early, and by what length
of time

If the flight has left the gate
Actual (or estimated) arrival time
Whether the arrival is delayed or early, and by what length of time
If the flight has landed or is at the gate
Information about any delays or cancellations (for example, delays
due to equipment substitution or weather)

Schedule information is displayed for all other flights. This includes:
Departure and arrival airports
Scheduled departure time

Scheduled arrival time

5. When you have finished reviewing the flight status information, click
Close to return to the Check Flight Status dialog box.

6. If you wish, you can repeat steps 2 through 5 to view flight status
information for another flight.

7. To return to the Itinerary Window, click Cancel.
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Mileage Plus® Summary Information

United Connection lets you review Mileage Plus account balance
information for all individuals in the Traveler Editor whose traveler
information includes a Mileage Plus account number. This includes
member level, Original Program Balance, New Program Balance, Year-to-
Date Balance, and information about the last four credited flights.

To review Mileage Plus summary information:

1. From the Tools menu, choose Mileage Plus Summary. The Mileage
Plus Summary dialog box appears.

Mileage Plus® Summary

Account Information

Mame: | Crawfaord, Stephen j|

Account: 001171222333 Mileage Plus® Customer Service: .

Level: Betrigve

Account Summary Eriit:..
Description Total Close

Fecent Account Activity

Date Description |Miles | Bonus | Tatal

Mileage Plus Summary dialog box

2. In the Name field, select the person whose Mileage Plus summary
information you want to review. The list contains the names of all
individuals entered in the Traveler Editor whose traveler information
includes a Mileage Plus account number.

3. Click Retrieve. United Connection displays the person's account

number and Mileage Plus level, along with the Mileage Plus customer
service telephone number.



Chapter 10: Flight Status and Mileage Plus 129

4.

In the Account Summary table, review the selected person's Mileage
Plus balance information. The table displays the following information:

Original Program Balance. Displays the current balance in the selected
member's original Mileage Plus program account. This only applies to
members who accrued Mileage Plus frequent flyer miles before 7/1/89.

New Program Balance. Displays the current balance in the selected
member's new Mileage Plus program account. This includes all Mileage
Plus frequent flyer miles accrued since 7/1/89.

Year-To-Date Balance. Displays the total number of Mileage Plus miles
accrued in the current calendar year.

In the Recent Account Activity table, review the last four flights for
which the selected person received Mileage Plus miles. Miles, bonus
miles, and total miles are displayed for each flight.

6. To print the Mileage Plus Summary information, click Print.

7. Click Close to return to the ltinerary Window.
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Mileage Plus® Miles Between Cities

United Connection lets you compute the Mileage Plus frequent flyer miles
between two airports served by United Airlines or United Express. Mileage
information is available for most larger domestic and international airports.

Note: Mileage is only available if United or United Express operates a
scheduled non-stop flight between the specified airports.

To compute Mileage Plus miles between cities:

1. From the Tools menu, choose Compute Mileage Plus Miles. The
Mileage Plus Miles Between Cities dialog box appears.

Mileage Plus Miles Between Cities

Flight Information
FEram: |J0hn F Kennedy Intl [Mew rark, N

To |Los Angeles Intl (Los Angeles, CTa)

John F Kennedy Intl  Log Angeles Intl 2475

Total Miles: 2475
Clear |

Mileage Plus Miles Between Cities dialog box

2. In the From field, enter or select the origin airport.
3. Inthe To field, enter or select the desired destination airport.

4. Click Miles. United Connection displays the origin, destination, and
Mileage Plus miles between the two airports.

Note: If you are not already connected to the reservation system, you will
be prompted to connect in order to compute the mileage.

5. If you wish, you can repeat steps 2 through 4 to compute miles for
additional origin/destination pairs. United Connection displays the
mileage for each pair, as well as a running total.

6. To clear the displayed mileage information, click Clear.

7. To return to the ltinerary Window, click Close.



Other Options

In this chapter, you will learn how to:

Chapter

Review and edit system options

Use the Welcome Window

Review United Information

Use the Airport Search option

Connect to the reservation system

Connect via the Internet

Retrieve an itinerary from the reservation system
Copy an itinerary to another application

View an itinerary in Print Preview mode

Print an itinerary

Use the Print Setup option
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Please contact your
preferred Apollo
travel agency to
obtain their code.

——————— Agency Code: I:I

Reviewing and Editing System Options

United Connection lets you indicate whether or not you want to display
certain dialog boxes at startup and during planning. You provide this
information in the System Options dialog box. You can also enter the travel
agency code for your preferred Apollo travel agency. If you want to pick up
your tickets at an Apollo travel agency you will need to provide this code.

To review your system options:

From the Tools menu, choose System Options. The System Options
dialog box appears.

System Options
Flight Planning Dptions UNIIID&
o : . _ CONNECTI@N
IV Dizplay Flight Service Requests Summany after planning —

¥ Display prompt ko plan another fight

Car Planning Options

¥ Display Rental Car Service Requests after planring
Hotel Planning Options

¥ Display Hotel Service Requests after planning

System Options
V¥ Display Welcome screen at startup

Airport Selection List Options
Default Sort Order: | By Location Code
¥ Show US locations orly

Frefered Travel Agency

System Options dialog box

. To select an option, click in the box next to that option. To de-select a

selected option, click in the box to remove the check.

If you want the option of picking up tickets at your preferred Apollo
travel agency, enter the three- or four-character code for that agency in
the Agency Code field.

Click OK to save the information and return to the Itinerary Window.

If you entered an Apollo travel agency code, United Connection
validates the code and displays the name of the specified agency. This
travel agency name will appear in the Ticketing Options dialog box as
an available ticketing option the next time you reserve an itinerary.
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Using the Welcome Window

The United Connection Welcome Window is normally the first screen you
see after starting the program. This screen allows you to go quickly to any of
the following areas:

Personal Profiles (Traveler Editor dialog box)

Travel Planning (Itinerary Window)

Mileage Plus® (Mileage Plus Summary dialog box)
Flight Status (Check Flight Status dialog box)

United Information (Connection Column dialog box)

Choose an icon to go directly to the associated dialog box. Follow the steps
below if the Welcome Window does not appear automatically after you
start United Connection.

To display the Welcome Window:

1. In the Tools menu, choose System Options. The System Options
dialog box appears.

WL COME, LD

UNITED CONNECTION

FERSOMAL TRAVEL MILEAGE FLIGHT UMITED
FROFILES PLANMING PLUS® STATUS INFORMATION
It's eazy to United Connection | Get instant access | Meed to check the | Check here for the

streamling your
travel planning
with custom
profiles for yourself
and others... just
chooze your
preferences, and
United Connection
does the rest.

puts wau in contral
with convenient,
upeto-the-minute
information for
over 550 airlines,
50 rental car
companies, and
200 hatel chains.

to Mileage Pluz®
account
infarmation for any
traveler, including
the current
year-to-date
balance and a
summary of recent
activity.

status of a Urited
or United Express
flight? United
Connection can
show you the
latest schedule
and gate
infarmation at the
click of a buttan.

latest promational
offers, vacation
packages, and
opportunities to
earn bonus miles...
some anly
available to Urited
Connection
members!

United Connection Welcome Window

Click in the box next to Display Welcome Screen At Startup to
select that option.

Click OK to save your change and return to the Itinerary Window. The
Welcome Window appears the next time you start United Connection.




134 United Connection User Manual

Because the
information is
formatted as a
Help file, you can
"jump" to other
topics. Follow the
instructions in the
dialog box to view
all available
information.

Reviewing United Information

United Connection includes an information area that keeps you up-to-date
with current promotions from United Airlines. United Connection checks
for new information each time you connect to the reservation system and
informs you when an update is available. You will have the opportunity to
retrieve the new information immediately, or do so at a later time.

To review United Information:

1. Do one of the following:

From the Welcome Window, click the United Information icon.
The Connection Column window appears.

From the Tools menu, choose United Information. The
Connection Column window appears.

& Connection Column M=l E
File Edit Bookmark Options Help
Qontentsl §earch| Bach | FErrint | e | 23 | Cloze |

% Connection Column

UNITED
CONNECTI@N
2.0

Click here for information on upgrading to United Connection 2.0!

Attention: United Connection Electronic Ticket Users

Effective May 21, 1996, United customers traveling with an electronic ticket should be prepared
to present the credit card used to purchase the electronic ticket in addition to a photo 1D, The
credit card must be presented by the cardholder, even if he or she is not traveling.

New in September:

@ Introducing the United Connection Car and Hotel Bonus! ;l

Connection Column window

2. Review the information.

3. Click Close to return to the Itinerary Window.



Chapter 11: Other Options 135

To display U.S.
Only cities by
default, double-
click on this
option. The text is
displayed in blue
when the default
state is set.

Using the Airport Search Option

You can search for airports by city name, airport name, or airport code. The
Airport Search option appears automatically when you click on the arrow
next to any field in which you need to specify a location, including:

Dialog box Field name
Personal tab (Traveler Information dialog box) Home Airport
Add Flight dialog box From, To
Add Car dialog box Airport

Add Hotel dialog box Location
Mileage Plus Miles Between Cities dialog box From, To
Check Flight Status dialog box From

To search for an airport (or location):

1.

Click on the down arrow next to one of the fields listed above. The
Airport Search option appears.

To search for airports or locations in the United States only, select the
U.S. Only option. If you do not select this option, the list will display
both U.S. and foreign locations.

Select one of the following search options:

Cities. The left column displays a list of cities in alphabetical order.
The right column displays the airport(s) associated with that city.

Airports. The left column displays a list of airport names in
alphabetical order. The right column displays the city in which the
airport is located.

Location Codes. The left column displays a list of airport and
location codes in alphabetical order. The right column displays the
airport name and the city in which the airport is located.

The name of the default search option is displayed in blue text. Double-
click on an option to make it the default option.

Scroll down the list to find the airport or location you want to select. To
scroll quickly to a particular area of the list, type the first few letters of
the city name, airport name, or airport code you are looking for.

When you find the airport or location you want to select, click on that
entry to select it.
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If you choose
Internet Service
Provider, MSN, or
CompuServe, see
“Connecting via
the Internet” for
more information.

If you want United
Connection to
supply your
password each
time this dialog
box appears, select
the Remember
This Password For
Next Time option.

Connecting to the Reservation System

You must connect to the reservation system whenever United Connection
needs send or receive information. For example, you will need to connect
when you open a reserved itinerary, or if you request flight, car, or hotel
information. You request a connection in the Establish Connection dialog box.

Note: The Establish Connection dialog box appears automatically whenever a
connection to the reservation system is required. To display this dialog box at
any other time, choose Connect To Reservation System from the File menu.

E stablish Connection
Sign In I.INIIIDJ
Mileage Plus COMMNECTI@MN
Accourt: 00311900530 —
Possnd pr—

Connect
W Bemember thiz paszword for nest time

Calling Eram: | home jl

Modern... I Qialinglnfo...l

Establish Connection dialog box

To connect to the reservation system:
1. In the Password field, type your password.

2. If you are connecting via the United Airlines Network:

a. Verify the location displayed in the Calling From field. Click on the
arrow to display a list of the locations you have entered.

b. To change your dialing information or create a new location, click
Dialing Info. The Dialing Locations dialog box appears.

c. To change your modem settings, click Modem. The Modem Settings
dialog box appears.

3. When you are ready to connect to the reservation system, click
Connect. A dialog box displays the status of the connection.
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United Connection
uses Secure
Sockets Layer
encryption for all
Internet
communications.

To disconnect from the reservation system:
From the File menu, click Disconnect From Reservation System.

If you are connected to the reservation system and do not request
information for a period of 10 minutes, United Connection will ask if you
wish to remain connected. If you do not respond within 60 seconds, you
will be disconnected automatically.

Important: If you are connecting to the reservation system via the Internet,
disconnecting from the reservation system in United Connection (or exiting
United Connection) does not automatically disconnect you from the Internet.
See below for more information about disconnecting from the Internet.

Connecting via the Internet

When you choose Internet Service Provider, MSN, or CompusServe, you
will be accessing the reservation system via the Internet.

Establishing an Internet connection

When United Connection needs to connect to the reservation system, it will
attempt to establish an Internet connection. If an Internet channel is already
open, United Connection will automatically use the open channel to
connect to the reservation system (whether or not this channel corresponds
to the United Connection service provider you have specified).

If an Internet channel is not open, United Connection will request one and
displays a message if any further action is required. Some Internet Service
Providers (for example, MSN and CompuServe) automatically launch their
dialer when an Internet connection is required. Others require you to
launch the dialer yourself. If you are unable to establish an Internet
connection, see “Internet Connection Problems” in the Troubleshooting
section of the United Connection Help.

Note to Windows 95 users: Windows 95 automatically launches your Internet
dialer when a connection is required. If you have more than one Internet
dialer, it uses the default dialer. To override this default, you should launch the
dialer you want to use before starting United Connection.

Disconnecting from the Internet

Disconnecting from the reservation system in United Connection (or exiting
United Connection) does not automatically disconnect you from the
Internet. Because your Internet connection is managed by your service
provider's dialer, you must access the dialer to disconnect from the Internet.
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Retrieve from Reservation System

If you have saved a local copy of an itinerary file on you computer, you
should open that itinerary by choosing Open from the File menu. This
ensures that United Connection has all of the traveler information used to
create the itinerary. However, after you reserve an itinerary you can also
retrieve that itinerary directly from the reservation system. This allows you
to view your reservation even if the itinerary file has been deleted from your
computer, or if you are using United Connection on another computer that
does not contain a copy of the file (for example, your work computer).

Note: You cannot retrieve your itineraries from someone else's system. United
Connection can only retrieve itineraries created on the current system, or on
another system registered to the same user.

To retrieve an itinerary from the reservation system:
1. From the File menu, choose Retrieve From Reservation System. The
Retrieve From Reservation System dialog box appears.

Retrieve From Feszervation Syztem

Itineraries UMITED

Mame | Confimation Mumber| | | CONNECTIGN

Lo THIF A-03P

Retrieve From Reservation System dialog box

2. Review the list of available itineraries. The list shows the descriptive
name and confirmation number of all reserved itineraries created on the
current system (or on another system registered to the same user).

3. To retrieve an itinerary, highlight that itinerary name and click OK.
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Creating default profiles and travelers

During retrieval, United Connection will automatically create a default
profile for each traveler in the itinerary and save these profiles in the
Traveler Editor. This is necessary because United Connection does not
know which profile you chose when you created the itinerary (profile
information is not stored in the reservation system). If any travelers in the
retrieved itinerary are not included in the Traveler Editor, United
Connection will create traveler entries for those travelers as well.

Copying an itinerary to other applications

United Connection allows you to place a copy of the current itinerary on
the Windows Clipboard. You can then Paste this information into other
Windows applications that support the Paste command. To copy an
itinerary to the Clipboard, choose Copy from the Edit menu.
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Viewing an Itinerary in Print Preview Mode

As you create your itinerary, United Connection places the information in a
trip report that can be printed at any time. If you wish, you can view the trip
report in Print Preview mode before printing.

To view an itinerary in Print Preview mode:

1.

From the File menu, chose Print Preview. The Print Preview window
appears. The itinerary is displayed as it will be printed.

Itin1.itn - United Connection

Frirt. I IlertFage I Erey Fane. I o Fage I Zoom In

i
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ARRIVE: #on D6¢02797 10:46a  Laos Regeles T4kl (Los hogeles P WILES: 2473
IR

Bevia Lus higeles Ikl (Los Regeles COMPE:

BICKUE : Moa D6702/87 10:46a TERMINAL TYRE : Iateciediate

DROPOEE: Fei D6/06737 07:00a RRIE : 54.953/WKEWD + 33.93/0AKY USD
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Wyndham Hotels
CHECK-TW : #on D6/02/97
CHECK-OUT: Pei D6/D06797

Ios Rageles Tabl (Los Rogeles COME§:
5235 O Cantucy Elwd ROOK : Deluxe hoom 1 Xing hed
Ios Rageles 0 90045 RATE : 135.00/WIGHT 0D

a0 &30-g000

united 0020 VONSTOE - Euaineas EQUIE: Eaeing 767
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Trip Report dialog box

To get a closer view of the text, click Zoom In. Click this button again
to zoom in even closer. You can also zoom in by clicking on the area of
the window you want to view.

To zoom out, click Zoom Out.

If the trip report includes multiple pages, you can:
Click Two Page to display two pages at once.
Click Next Page and Prev Page to move from page to page.

To print the itinerary, click Print. The Print dialog box appears.

To exit Print Preview mode, click Close.
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Printing an Itinerary

As you create your itinerary, United Connection places the information in a
trip report that can be printed at any time.

To print an itinerary:
1. From the File menu, choose Print. The Print dialog box appears.

Print H

— Printer

I ame: IQMS 202543225 Print System

Statug: Ready
Type: QM5 202543225 Print System
Where:  \\Sexoel08hexo2-gms

Comment: ™ Pririt to file
— Print range Copies
Al Murnber of copies: |'| 3:
" Pages from: [1 to
-
£ SEle i
oK | Cancel I

Print dialog box (Windows 95)

2. The name of the current printer appears at the top of the dialog box.

Window 3.1, 3.11, and NT 3.51: To select a different printer, click
Setup. See "Using the Print Setup Option" for more information.

Windows 95: To select a different printer, click on the arrow next to the
Name field and select the printer you want to use. To view and/or
modify additional printer options, click Properties.

3. Choose one of the Print Range options. The default is All. If you select
the Pages option, be sure to specify the page range you want to print.

4. In the Print Quality field (Windows 3.1, 3.11 and NT 3.51 only), select
the desired printer resolution.

5. If you want to print multiple copies of the trip report, enter the desired
number of copies in the Copies field. Choose Collate to have each
copy collated automatically.

6. To print the trip report, click OK.
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Using the Print Setup Option

United Connection lets you define certain printer setup options, including:

Printer
Orientation
Paper size
Paper source

Printer-specific options

Note: In order to select and configure a printer, you must have already
installed that printer driver on your system using the Windows Control Panel.
Refer to your Windows documentation for more information.

To setup your printer:

1.

From the File menu, choose Print Setup. The Print Setup dialog box
appears.

. Select the printer you want to use:

Window 3.1, 3.11, and NT 3.51: To use your system's default printer (as
specified in the Control Panel), select the Default Printer option. To
choose a different printer, select the Specific Printer option. The list
displays all printer drivers currently installed on your system.

Windows 95: Click on the arrow next to the Name field to display a list
of installed printers. The status, type, output location, and any
comments related to the selected printer are displayed below the name.

. Choose one of the Orientation options: Portrait (vertical orientation) or

Landscape (horizontal orientation). The default is Portrait.

In the Size field, choose the size of the paper you will be using. Options
vary by printer.

In the Source field, choose the paper source. Options vary by printer.

To view and/or modify additional printer options, click Options
(Properties in Windows 95). Available options vary by printer.

To save the print setup information, click OK.
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Getting Help

This chapter includes information about:
Using the Online Help
Getting Technical Support
Troubleshooting

Comments and Suggestions

About getting help

When you need help using United Connection, your first resource should
be the online Help. This information can be displayed quickly when you
need it most... as you are working. This User Manual can help you learn
how to use United Connection and complete specific travel planning tasks.
Also, be sure to check all README files included with the software.

For answers to commonly asked questions about United Connection, turn
to the Troubleshooting section in this chapter. If you need additional help,
you can contact the United Connection Support Desk at 1-800-4UA-
CNXN (1-800-482-2696). To ensure a quick resolution to your problem,
please read the Support Desk guidelines provided later in this chapter.
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Before calling,
please note the
exact wording of
any onscreen
messages related to
the problem you
are experiencing.

Using the Online Help

United Connection includes complete, comprehensive online Help that
should be able to answer most of your questions. As you use United
Connection, you can access Help in any one of the following ways:

Click Help in a dialog box to get specific Help for that dialog box.
Press the [F1] key to get Help for the current window or dialog box.

From the Help menu, choose Contents to display the main Help
window, or choose Search For Help On... to display an index of
available Help topics.

To get help on Help, press [F1] while the Help window is displayed.

Getting Technical Support

If you need help, the United Connection Support Desk is available from 6
a.m. to 1 a.m. (CT) seven days a week at:

1-800-4UA-CNXN (1-800-482-2696)

After hours, you can reach us by fax at 1-847-427-6157, or via E-mail at
73420.1674@compuserve.com. Please include the following information:

Your name, address, and Mileage Plus number.
Descriptions of the problem and your operating environment.

A phone number (and fax number, if possible) where we can contact
you. Also, please indicate the best day and time for us to call you.

Troubleshooting: Questions and Answers

This section includes solutions to problems that may occur as you use
United Connection. If you don't find the answer you need here, you can
refer to the online Help or contact the Support Desk for assistance.

Not enough memory

When | try to start United Connection, | get the message "Not enough
memory to run application." What should I do?

Verify that your system has a minimum of 8MB of RAM (memory).

If you don't know how much memory your system has, you can check it
from DOS using the MEM command (DOS versions 5.0 and higher). At
the DOS prompt, then type MEM and press [Enter].
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Make sure all other applications are closed.

Windows 3.1/3.11/NT 3.51 users can check this by displaying the Task
List (press the [Control] and [Escape] keys at the same time).

Check your available memory, as follows:

In Program Manager, click on the Help menu and choose the last
option, About Program Manager. An entry at the bottom of the
dialog box indicates how much memory is free. If this value is less than
12,000 KB, you will need to increase virtual memory. Refer to United
Connection's online Help for more information.

Use MemMaker (a utility included with DOS 6.0 and higher) to load all
device drivers into high memory.

Do not use this command while Windows is running. Exit to DOS and
type HELP MEMMAKER for more information about this utility, or refer
to the chapter entitled Making More Memory Available in the MS-DOS
6 User's Guide.

Registration

I didn't enter my Mileage Plus number when | registered, and a new
number was assigned automatically. What should I do?

To use the new Mileage Plus number exclusively, you will need to write
to the Mileage Plus Service Center requesting that they close your old
account and transfer all accrued miles and benefits (including earned
Premier status) to your new account number. The address is:

Mileage Plus Service Center
P.O. Box 28870
Tucson, AZ 85726

Include your name, address, and a brief note indicating that you want to
use the new Mileage Plus number exclusively. The transaction will be
complete in four to six weeks.

To retain your previous Mileage Plus number, you will need to re-install
the software and re-register using your original Mileage Plus number.

If you have earned any Mileage Plus miles with your new Mileage Plus
number, you must write to the Mileage Plus Service Center at the
address above to request consolidation of the accounts. Include your
name, address, and a brief note indicating that you want to use your
original Mileage Plus number exclusively. The transaction will be
complete in four to six weeks. If you have purchased tickets with your
new Mileage Plus number but have not completed the travel associated
with those tickets, please contact United Airlines directly to ensure that
the flight miles are credited to your original Mileage Plus account.
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I just registered and was instantly enrolled in Mileage Plus — why can't |
use my new Mileage Plus number to log in on another computer?

If you enroll as a new Mileage Plus member when you register, there is

a one- to three-day delay before you can use your Mileage Plus number
to log in on another computer (on which you have also installed United
Connection). Please wait a few days and try again.

United Connection dials and connects but is unable to register.

Try a different local access number. If that fails, try connecting again
later. For additional help, please contact the United Connection Support
Desk at 1-800-4UA-CNXN (482-2696).

United Connection won't accept my credit card.

In the Credit Card Registration dialog box, be sure that you have
entered your credit card number without any spaces or hyphens.

In the address area, make sure that you have entered your address
exactly as it appears on the credit card statement.

Note: Try to fit the whole street address in the first line. If the address is
too long, delete the text for Apt or Suite but retain the number.

If you are using a corporate credit card, you must enter the company
name exactly as it appears on the credit card billing statement.

If you continue to have problems, try a different credit card.

I'm getting a “Form of payment invalid” message.

Please contact the United Connection Support Desk
at 1-800-4UA-CNXN (482-2696).

How do I change my name in United Connection?

If you are not the registered user, simply access your traveler
information in the Traveler Editor and change your name.

If you are the registered user, you first need to call or write Mileage Plus
to inform them of the name change. Refer to your Mileage Plus
membership information for the customer service phone number and
mailing address. If you request a name change by phone, the change
will be made within 2 to 3 days. If you request a name change by mail,
the change will be made within 7 to 10 days. Once Mileage Plus has
made the change, you should change your name in both the
Registration dialog box and in the Traveler Editor.
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Modem and communication problems
(United Airlines Network only)

I get a modem error message, or no response from the modem.

Make sure that your modem is connected to the phone line. If it is an
external modem, make sure it is turned on.

Make sure that your modem is connected to the COM port you selected,
and that no other software is using that COM port (for example,
modem/fax software or remote access programs).

Make sure that the Primary and Backup numbers you selected support
your modem speed. You should choose an access number that uses the
highest speed supported by your modem. Do not select an access
number whose modem speed is faster than your modem.

Reset the modem.
External modem: Turn the modem off and on.

Internal modem: Close all applications, turn off your computer, turn it
back on again, restart Windows, then restart United Connection.

Refer to you modem owner's manual for configuration information and
suggestions on entering a customized initialization string.

Windows 3.x: Did you use the Test Settings button? If not, do this
(from the Tools menu, choose Communications/Modem Settings).

Windows 3.x: Make sure you have selected the correct vendor and
modem type. If you cannot find your modem in the Modem Type dialog
box, choose Hayes Compatible from the Vendor list and Any Hayes
Compatible Modem (the only option) from the Modem list.

Windows 3.x: Choose a lower Speed setting in the Modem Settings
dialog box. If you don’t know your modem speed, select 9600.
Other modem problems.

Refer to Troubleshooting in the online Help or call the Support Desk.

I can't connect to the reservation system using either the Primary or
Backup access numbers | selected. What should | do?

Make sure that the information you entered in the Dialing Information
dialog box is correct. If you cannot connect, you may have entered an
invalid dialing prefix or calling card number.

One or both numbers may be temporarily unavailable. Edit the dialing
information and choose different access numbers in your area code.
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Internet connection problems

Note: If you still have problems connecting to the reservation system via your
Internet Service Provider after troubleshooting, select "United Airlines
Network" as your United Connection service provider.

Internet connection error messages:

"Unable to find an Internet Service Provider. Please establish a
connection with your Internet Service Provider before continuing."

You must have an account with an Internet Service Provider in order to
connect to the reservation system via the Internet. If you have an
account with an Internet Service Provider, you should launch that
service provider's dialer before proceeding. Otherwise, choose the
United Airlines Network as your service provider option.

"Unable to establish a connection. Make sure that you are connected
to the Internet via your Internet Service Provider. If you have a valid
Internet connection but cannot access the reservation system, please
try again later."

This message can be displayed for the follow reasons:
Your Internet Service Provider dialer did not launch when required
Your Internet Service Provider cannot connect to the Internet
Your modem or dialing information is incorrect
MSN: Your MSN account may not be configured for Internet access
Windows 95/NT: You are not using 32-bit Internet software

Problems connecting to the Internet over a LAN (network)

Please refer to Troubleshooting in the online Help for more information.

"Internet connection has been lost. Please reconnect to the Internet via
your Internet Service Provider."

If you get this message, you will need to access your service provider's
dialer and re-establish your Internet connection. Contact your service
provider if you are unsure how to do this.

"A communication error has occurred. Please try again."

United Connection will display this message if it was unable to receive
the requested information from the reservation system. If you get this
message, you should request the information again by reselecting
whatever option you had just selected in United Connection.
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I keep getting disconnected.

Is someone else at your location trying to use the same phone line? If
someone at your location picks up a telephone that is connected to the
same line as your modem, you will be disconnected.

Do you have Call Waiting? If you do, you should disable it before using
United Connection. See the online Help for more information.

United Connection isn’t using the Service Provider I selected.

To ensure that United Connection uses a specific Internet Service
Provider, you should launch that Service Provider’s dialer before starting
United Connection. Otherwise, the system will (in most cases) use the
default Internet dialer. If an Internet channel is already open, the system
will use that channel (whether or not it corresponds to the United
Connection service provider you have specified).

Flights and fares
What is the best way to find low fares?

Use FareShopper™. You provide your travel plans and preferences, then
United Connection searches for low fares to your destinations. See
Chapter 6, Selecting Flights, for information about using this option.

Purchase your tickets as far in advance as possible. Many low fares
require that you purchase tickets 7, 14, or 21 days in advance.

Select round-trip flights — one-way flights are usually more expensive.

To meet minimum stay requirements, plan your trip so that you stay
over a Saturday night.

Check flights at different times of day. Early morning and late evening
flights can be less expensive.

If your schedule permits, fly mid-week (flights are often less expensive).

In Flight Preferences, make sure that you have selected all three Fare
Restriction options (Minimum Stay Required, Maximum Stay Required,
and Advance Purchase Required). See Chapter 6, Selecting Flights, for
information about changing flight preferences for the current flight.

FareShopper couldn't fare quote my itinerary — what's wrong?

If your itinerary includes more than four planned flights, FareShopper
may not be able to return any fares. If an error message is displayed in
this situation, you will need to exit FareShopper and select each flight
individually. In the Itinerary Window, highlight a Planned flight and
choose the Find icon from the toolbar to display available flights.
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FareShopper didn't display any flights for the fare I selected.

If FareShopper doesn't display any flights after you select a fare and
click Next>, you need to select a different fare. Click <<Fares to return
to the FareShopper(sm) Fares dialog box.

When I choose an international destination in the Add Flight dialog box,
no flights are displayed. What should 1 do?
International destinations have fewer scheduled flights. Try selecting an
earlier departure time or a different departure date.
Why can't | select seats from a seat map for every flight?

Seat maps are provided for United and United Express flights only. If
you have selected another airline, seat maps will not be available.

If you can't display the seat map for a United or United Express flight,
that seat map may be temporarily unavailable. If you wish, you can try
to display the seat map again later and choose your seats at that time
(even if you have already reserved the flight).

Seat maps will not be available if you have selected connecting flights
that require you to change planes.

Seat maps cannot be displayed if the flight you selected is scheduled to
depart within 60 minutes (seats will be assigned at the airport).

Why was my special meal request denied?

You cannot request a special meal on flights that are scheduled to
depart within 24 hours.

The meal you requested may not be offered by the selected airline.

The flight you selected may not offer meal service (meal service is not
offered on flights lasting less than 90 minutes).

Why did I get the wrong flight information when I requested Flight Status?

If the flight originated at an international location or on a different day,
you may not get status for the correct flight segment. To ensure that you
get the correct information, enter an origin airport in the From field.
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Selecting rental cars

I entered my rental car planning information and chose Find Cars, but no
rental companies are displayed. What should 1 do?

United Connection only displays rental car companies that meet all of
the preferences specified in the primary traveler's profile. If a message
indicates that a particular preference could not be met, edit your rental
car preferences to change that option. You can also turn off all
preferences by de-selecting the Use Preferences option in the Select
Rental Car Company dialog box.

Selecting hotel accommodations

I want to make reservations at a specific hotel. Why don't I see it in the list
when I choose Find Hotels?

Because the reservation system contains a large number of hotel listings,
United Connection will probably not be able to display all of the listings for
a particular location at one time (especially in larger metropolitan areas). To
find the hotels you are looking for, do the following:

Make sure that the hotel you want to choose is specified as one of the
Preferred Hotel Chains in the primary traveler's profile.

Make sure that the hotel is within the specified distance from the
reference point you selected in the Add Hotel dialog box. Different
references points are provided for each location.

In the Select Hotel dialog box, click More Hotels to see additional
properties at that location.

Reserving
Why do I have to select a credit card if I'm not paying for my ticket now?

United Connection requires a contact address, in case we need to reach
you concerning changes to your itinerary. The address of the credit card
you select is used as the contact address. If you are not paying for your
tickets online, the credit card will not be charged.

I reserved my itinerary yesterday — why is the airfare higher today?

Your airfare is not guaranteed until you pay for your tickets... even if you
reserve your itinerary. To guarantee your airfare immediately, choose
Electronic Ticket, Express Delivery, or First Class Mail Delivery as your
ticketing option. If you choose United Ticketing Locations or your
preferred Apollo travel agency, your airfare is not guaranteed.
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United Connection couldn't confirm my reservation. What should 1 do?

If time is not critical, wait a while and then try again. The reservation
system may be able to confirm your reservation at a later time.

If you are concerned about holding space on a flight or guaranteeing a

particular airfare, you should call the airline(s) directly. If your itinerary
includes any rental cars or hotel rooms, you should call these providers
directly to make your reservations.

Windows 95

I am running Windows 95 and a software download was started. Now I'm
stuck on an open window that displays the word PATCH, and indicates the
number of files being processed. What should I do?

The open window has patched your software. To continue the upgrade
process, click the X at the upper right corner of the window.

I am running Windows 95 and the download process stopped with an
error saying an invalid statement was being executed. What should 1 do?

You have run out of hard disk space and need to either delete some files
from the Recycle Bin or delete obsolete files or programs. Clear some
space on your hard drive, then re-start United Connection and select
Connect To Reservation System from the File menu to begin the
software download process again.

Comments and Suggestions...

As you use United Connection, you might have comments, suggestions, or
experiences that you would like to share with us. We would particularly
appreciate receiving your feedback on the issues listed below.

Ease of use

Features you frequently use

Features you rarely use

Your favorite product features

Product features you dislike

Anything you'd like to see added to the product

Features you’d like to see improved

Whether you used this manual and online Help (and if it helped)
If you could make one change, what would it be and why

To share your experiences with us, call 1-800-4UA-CNXN, choose the
feedback option, and leave a voice mail message.
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